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Welcome
With Laplink Gold 12, access files on remote PCs and servers; transfer and synchronize data 
between PCs; run database applications on remote computers; provide remote technical support to co-
workers or friends; operate, maintain, and even reboot remote PCs or servers - Laplink Gold 12 allows 
you to do all of this with a single application, no matter where you or your PCs may be located. If you want 
to keep your data synchronized or you are an IT professional needing to support remote users, Laplink 
Gold 12 gives you a level of mobility, independence and control you may never have thought possible 
within a single application. 

What’s new in Laplink Gold 12
Laplink Gold 12 sets the standard in PC connectivity with its 
new Laplink Remote Desktop, Laplink Internet, integrated 
antivirus scanning, streamlined user interface and Laplink 
USB 2.0 cable connectivity.
Laplink Remote Desktop
Laplink Remote Desktop allows users to use Remote Desk-
top control features built into Microsoft XP Professional, 
Windows Server 2000 and 2003 while taking advantage of 
all the other features of Laplink Gold 12, such as its secure 
Internet connectivity via Laplink Internet.
Laplink Internet
Enables users to reliably and easily connect to remote com-
puter(s) through firewalls and proxy servers without com-
promising security or setting special port configurations.
Integrated Antivirus Scanning
Allows users to transfer files and ensure that they are virus-
checked, cleaned and, if necessary, quarantined.
User Interface
The new user interface is user friendly with a Microsoft Win-
dows XP look and feel. Included is a Windows Explorer-like 
sidebar to keep common tasks accessible while hiding 
tasks that cannot be currently performed.

USB 2.0 Support
Laplink Gold 12 supports enhanced USB 2.0 cables for dra-
matically increased file transfer speeds. The retail box ver-
sion of Laplink Gold 12 includes a USB 2.0 cable. Volume 
discounts available for bulk purchases. 

System requirements
Your computers must meet these requirements to install 
and run Laplink Gold 12:
• Microsoft Windows 98 SE, Me, 2000, XP or Server 

2000 and 2003
• Laplink Gold 12 does not support Windows 95 or NT
• 133 MHz or higher Pentium-compatible CPU
• At least 64 megabytes (MB) of RAM; more memory 

generally improves responsiveness
• 30 MB of available hard disk space (for a complete 

installation)
• CD-ROM or DVD drive
• Display VGA or higher resolution monitor
• Keyboard and mouse required
However, Laplink Gold 12 will connect to computers run-
ning Laplink versions 7.5 and higher.
7
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Versions of Laplink prior to 7.5 may have trouble connecting 
to Laplink Gold 12. For more information see ”General secu-
rity” on page 16

About this guide
This documentation will assist you in using Laplink Gold 12 
and acquaint you with its features, operation, and will pro-
vide a detailed product overview.To improve the usability of 
this guide, step procedures are now located in the online 
help system.
While you are setting up and using Laplink Gold 12, activate 
the Quick Steps window and the Laplink help system.

Key terms
Guest: The computer you are using. Regardless of loca-
tion, the computer initiating an outgoing connection is the 
Guest computer.
Host: The computer to which you are connecting. It is host-
ing your connection. Regardless of location, the computer 
accepting an incoming connection is the Host; it is allowing 
the Guest to control it.

NOTE Laplink Software also offers Laplink Gold Host 
for volume license customers who require the ability to 

gain remote control of Host computers to provide tech-
nical support and administration. Laplink Gold Host only 
allows incoming connections to be completed onto the 
Host computer(s) by authorized users who have 
Laplink Gold running on their Guest computers.

Local: Used to refer to the location of a printer. A “local” 
printer is connected to its computer. 

Icons
Product icons are used in this document to acquaint you 
with the features of the product.

Contacting Laplink
If you are unable to resolve the issue, please contact 
Laplink support at www.laplink.com/support
Have the following information available when contacting 
Laplink support:
• The serial number of your version of Laplink Gold 12.
• The version of Microsoft Windows running on the Host 

and Guest computers.
8
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Features, Tools and Users
You can do so much more than share files with Laplink Gold 12. It is ideal for troubleshooting computers 
at remote locations or for working on your office computer while you’re on the road. Features like 
Xchange Agent and Remote Control save time and simplify your work. Tools like Address Book and 
Security allow you to manage who can access your computers and what features are available to them. 
Laplink Gold gives you the freedom to leave the office without giving up access to your office computer 
and network resources. Whether you’re traveling on business or working from home, you can still read 
your e-mail, share the latest files with co-workers, access network programs and databases, browse the 
Internet and collaborate with colleagues. Things you once could do only in the office you can now do 
remotely.

Features
File Transfer transfers files between computers.
With File Transfer, you can move or copy files between 
computers. Customizing any of the several File Transfer 
settings simplifies complicated transfers. Laplink’s patented 
SpeedSync technology makes updating files faster 
because files are compared, and only changes —not entire 
files—are transferred. A comprehensive security system, 
including encryption and virus checking protects your valu-
able data at all times.
Xchange Agent synchronizes files and folders.
With Xchange Agent, you can synchronize sets of files or 
folders between two computers or between local drives. 
Use Xchange Agent to transfer vital information to and from 
a portable computer, or to back up important files. You can 
schedule Xchange Agent to run regularly, so that your infor-
mation is always up to date; Xchange Agent automatically 
connects, transfers files, and disconnects.
Remote Control lets you work on a computer at another 
location. 
With Remote Control, control another computer as though 
you were sitting at that computer using its keyboard, mouse, 

and programs while looking at its screen. Whether your 
computer is controlling or being controlled, you have the 
same setup and start-up procedures. You can even copy 
information from one computer application and paste it to 
the other.
Laplink Remote Desktop lets you access Windows 
Remote Desktop on Microsoft Windows XP Profes-
sional, Server 2000 and Server 2003.
With Remote Desktop, access the enhanced remote control 
experience available via the Remote Desktop features built 
into Windows XP Professional and the Terminal Services 
features built into Microsoft Windows Server 2000 and 
Server 2003. You may need to purchase Microsoft Terminal 
Services Server licensing separately.
Connecting through firewalls with Laplink Internet.
With Laplink Internet, securely connect to PCs and servers 
behind firewalls without needing to reconfigure, disable or 
open up ports on firewalls and/or proxy servers. Once you 
create your Laplink Internet account and associate the com-
puters you will want to connect with your account, log onto 
any of those computers from any other computer running 
Laplink Gold 12. The first year of the Laplink Internet service 
is included at no additional cost.
10
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Text and Voice Chat features let you communicate in 
real time with the person on the other computer. 
With Text Chat, exchange messages with someone by typ-
ing messages in a window. This is useful if you need to 
communicate with the person at the other end while per-
forming other services like File Transfer and Remote Con-
trol. Text Chat information is saved, and you can also cut 
and paste text into the Text Chat window.
With Voice Chat, talk with someone while you perform other 
services like File Transfer and Remote Control. Voice Chat 
requires a microphone and sound card on each computer.
Print Redirection lets you print documents on a printer 
attached to another computer.
With Print Redirection, you can print a document from a 
Host computer to your local printer over Remote Control, or 
print local documents to a printer at a Host location. This 
means you don't have to use File Transfer to get documents 
printed where you want them.

Tools 
Address Book stores your host computer connection 
types and permissions. 
With Address Book, create lists of the Host computers to 
which you want to connect. The Address Book stores the 
connection type used to access the Host and the services 
you want to start automatically upon connecting.

Security sets access privileges on your computer.
Laplink provides two authentication methods: Microsoft 
Windows Authentication and the standard Laplink authenti-
cation. With Windows Authentication, now you can give 
Windows domain users access to your computer, allowing 
them to use their domain usernames and passwords. You 
can easily limit the services available to any users and set 
up log-in credentials. Encryption and Lock Out options 
provide another layer of security.
Antivirus checks incoming and outgoing files for virus 
infection.
A new integrated Antivirus feature keeps your Guest and 
Host computers safe from computer virus infection by 
checking all incoming and outgoing files with a powerful 
virus scanning engine. Automatic updates keep your com-
puters safe while you can configure preferences to allow 
you to determine the level of protection you need.

Users 
Most Laplink Gold 12 users will use Laplink to connect to 
their personal information, to synchronize their workstation 
and laptop, or access network resources. 
Advanced users are typically IT and Support professionals 
who use Laplink Gold 12 to access large groups of comput-
ers and users, offer integrated support and troubleshoot 
problems. Advanced users would use features such as the 
Address Book’s section in ”Importing and Exporting” on page 
42 to manage large lists of users and their credentials. 
Advanced features are available to everyone.
11
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Getting Started

Now that you have installed and started Laplink Gold, you need to determine your permissions, 
credentials and connection types. Then you will be ready to configure Laplink Gold 12 for incoming 
Laplink connections using Security settings and for outgoing connections using the Address Book. 
Laplink’s versatility allows connectivity over a dial-up connection, office network, the Internet and more.

How will you use Laplink Gold 12?
Before you set up Laplink Gold 12, take a few moments to 
determine how you want to use Laplink Gold 12.
Laplink Gold 12 is a versatile remote access product that 
helps you solve your multi-computer connectivity chal-
lenges. 
This section gives brief scenarios of the typical tasks you 
can perform with Laplink Gold 12. 

Staying connected
Laplink Gold 12 allows you to remain connected to the data 
and devices that you need to use no matter where you are. 
While traveling, use a connection at the hotel to retrieve 
data stored on the network at the office. At home, access 
critical information. Laplink’s robust features give you the 
information you need when you need it. 

IT and support - Advanced features
Laplink Gold features like Global Address Book and Win-
dows Authentication help you manage large groups of 
users within your organization. Using the powerful Address 
Book features, all connection information can be stored 
centrally. This allows you to share saved connections with 
your IT team so that everyone has needed connection infor-
mation at their fingertips. Microsoft Windows Authentication 
lets you set up domain users easily with their current net-
work credentials. With Laplink, you can offer remote support 

and troubleshooting to your users, no matter your or their 
locations.You can also help spread the workload and share 
information.

Connecting for the first time
If you have never used Laplink before, you will need to 
determine credentials, permissions and connection types 
for your incoming and outgoing connections. The informa-
tion in this chapter will help you determine your require-
ments
If you are upgrading to Laplink Gold 12, there are no spe-
cial procedures you need to follow. All of your previous 
settings will appear in Laplink Gold 12. While it is advanta-
geous to install Laplink Gold 12 on all computers you will 
be accessing, you will be able to connect to computers 
running Laplink Gold 7.5 and higher.

Security
Security settings manage incoming connections; they 
determine who is allowed to connect to your computer and 
what Laplink services they have access to. 
Before you configure your security settings you need to 
know the authentication type you will be using.

Laplink Authentication
Laplink authentication allows you to assign credentials 
(User Name and Password) to incoming connections. The 
13
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advantage of Laplink Authentication is that you control the 
access credentials, which allows you to modify them at any 
time. 
• If you are the only one accessing your computers via 

Laplink, assign yourself a User Name and Password.
• If another Laplink user is accessing your computer, you 

will need to tell them their Laplink User Name and 
Password.

Windows Authentication
If you are on a network domain, you may be able to use 
Windows Authentication to grant permissions. The advan-
tage to using Windows Authentication is that users have 
familiar credentials to access Laplink - they are the same 
ones they use on the office network. To grant credentials to 
a network user:
• You must be logged onto the network domain. 
• You must know their user name.

Address Book
The Address Book manages outgoing connections. It con-
figures the connection type and default services you will use 
to access a Host. 

Before you configure your Address Book you need to know 
the credentials granted to you by the Host computer. For 
each Address Book entry,
• know your connection type;
• know the credentials (User Name and Password) 

needed to connect to the Host;
• know what services you have been given permissions 

to (File Transfer, Remote Control, etc.);
• Know the Laplink computer name.

Connecting through Firewalls
Laplink Gold 12 provides several options for making con-
nections through firewalls. The easiest is Laplink Internet. 
Laplink Internet ensures secure connections and requires 
no special configuration of firewalls. To use Laplink Internet, 
you must first create an account with the Laplink Internet 
service. The first year of the Laplink Internet service is 
included at no additional cost.
See “Connection Types” on page 37.
Once connection is completed, log in from any Laplink Gold 
12 computer and see any of your computers associated 
with your Laplink Internet accounts as long as they are run-
ning Laplink Gold 12, and are currently online and available 
for connections. 
However, you may choose to establish connections by re-
configuring the firewall. There is a detailed tutorial available 
on the Laplink support site (http://www.laplink.com/support), 
that will guide you through step-by-step instructions for con-
figuring a firewall connection. 
14
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Computer Name

When you first installed Laplink, you were asked to enter a 
unique name for your Laplink Computer. In order to config-

ure outgoing connections in your address book, you need to 
know the name of the computers you will be connecting to.
From the main menu select Options > Computer Name to 
see or change the computer name on a Laplink computer. 

NOTE You must close all connections prior to modify-
ing a Laplink computer name.
15



Laplink Gold 12

Configuring Security
Before you can receive incoming connections, you need to configure your Laplink Security settings. By 
default, Laplink is installed to only allow outgoing connections. There are four security tabs in Laplink Gold 
12 - General, Local, Encryption and Lockout. This section walks you through these security options, 
and explains the value of each feature. For detailed step-by-step instructions on configuring your security 
settings, go to the on-line Help system. To access Laplink’s Security features, from the main menu select 
Options and then Security.

General security
From the General security tab you determine the level of 
security for incoming connections and set credentials and 
permissions.

Allowing incoming connections
As a safety precaution, Laplink’s default security setting is 
Private System. After you install Laplink, you can connect 
to other computers, but other computers cannot open con-
nections to yours, except by cable or infrared.
To allow incoming connections, you can change the secu-
rity setting to Public System. For more security, change the 
security setting to Protected System and create one or 
more entries in the Log-in List. In each entry, specify the 
password and the login name the user must provide to open 
an incoming connection, and grant the user permission to 
use services and other features.
The safest way to allow incoming connections is to set up 
password-protection by creating entries in the Log-in List. 
If you will be the only person to connect to this computer, 
make a single Log-in List entry and grant yourself whatever 
privileges you want. For other users, create separate entries 
for each user.

Specifying passwords
Laplink Gold passwords are case-sensitive (i and I, for 
example, are treated differently). For incoming connections 
from computers running Laplink Gold, you can create 
secure passwords by mixing capital letters and lower case 
letters.Case sensitivity has these important consequences:
• By default, security is not imposed on incoming connec-

tions over a cable. If you set up password protection for 
modem and network connections, however, you can 
extend that protection to cable and wireless connection 
as well. On the Local Security tab, check this box: 
Enforce Security for Local Connections

• If your Log-in List contains passwords assigned in an 
earlier Laplink version, other computers that have also 
upgraded may not be able to connect to your computer 
until you assign new passwords.

• For incoming connections from computers running ver-
sions earlier than Laplink 2000, type passwords using 
ALL CAPITALS. If your Log-in List has passwords for 
such connections, retype them as all capitals, or assign 
new passwords.
16
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Creating your Log-in List
Laplink Gold supports two different ways of allowing con-
trolled access to your computer: Laplink Authentication and 
Microsoft Windows Authentication. Both can be used at the 

same time. The following section outlines the security fea-
tures of Laplink Gold 12. 
You can modify your security settings at any time.

In order to set Log-in privileges, you must know the secu-
rity model you want to use, and the credentials for all 
incoming connections you want to add.

Manage your incoming connections by configuring security

Nobody is the highest level of security. It allows you to 
connect to other computers and prohibits incoming 
connections. 
IT professionals might use this setting on a computer 
used for support that does not require user access.

Anybody allows incoming connections from all Laplink 
enabled computers who can see your machine. 
To enhance security you can limit access to folders avail-
able to incoming connections by selecting Public Priv-
leges. 
17
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Your security model determines how you assign credentials—User 
Name and Password—to incoming connections

 Security Model window 

Laplink Authentication involves creating a login 
list of user names and passwords. A login list is 
unique to the computer that it is created on and 
cannot be exported or shared with other Laplink 
computers.

Microsoft Windows Authentication is extremely 
useful for people who are on a Windows Active 
Directory Network. This feature allows you to give 
Laplink access to network users, so that users 
need only their Windows network user names and 
passwords to access the Laplink functions of your 
computer.
18
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.

Security Model - Laplink Authentication 

Select the services you want the 
Guest to have on your Host com-
puter. 
When allowing Remote Control 
access to the Host, you can 
choose to have the Host’s screen, 
mouse and Keyboard disabled.

Enter the log-in credentials for the 
incoming connection to your 
Host. 
Make sure the Guest has this 
information.

TIP For more information on 
configuring Firewall connec-
tions see the tutorial on the 
Laplink support site. From 
Laplink’s main menu, select 
Help, then Tutorials on the 
Web.
19
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Security Model - Microsoft Windows Authentication 

Select the services you want the 
Guest to have on your Host com-
puter. 
When allowing a Remote Control 
access to the Host, you can dis-
able the Host’s screen, mouse 
and keyboard.

Select the Domain on which the 
Guest is located.

Select and Add user(s) from the 
Domain User list.

TIP For more information on 
configuring Firewall connec-
tions see the tutorial on the 
Laplink support site. From 
Laplink’s main menu, select 
Help > Tutorials on the 
Web.
20
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Folder security
Whether you use Laplink Authentication or Microsoft Win-
dows Authentication, when you open your computer to 
incoming connections, you can specify if all drives and fold-

ers—or only certain ones—are accessible to users who 
connect to your computer for File Transfer. You can also 
grant different privileges to different users. 

Folders denied access do not 
appear in File Transfer windows 
on a Remote computer.

Folder Security window

Folder Security is an option 
available for both Log-in List and 
Public Security.
21
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Opening your computer to incoming connections does not 
mean that files on all your drives and folders need to be 
accessible to other users. You can “hide” certain drives and 
folders so that other users will not see them in their File 
Transfer windows and cannot copy files to or from them.

CAUTION You can specify a different setup for each 
entry in your Log-in list. Until you specify otherwise, 
every user in your Log-in List is allowed access to all of 
your drives and folders.
CAUTION Denying access to a drive or folder makes 
it invisible to anyone who connects for File Transfer but 
has no effect in Remote Control. Anyone who connects 
for Remote Control can still access all of your files.
TIP Navigate through the drives and folders on the 
Folder Security tab much as you do in a File Transfer 
window. For fastest navigation, double-click a drive or 
folder or click the plus sign beside it.

Modem Callback
When you allow incoming modem connections, you can 
require that the Guest computer be called back before a 
connection is opened. Or you can let the Guest computer 
determine whether to be called back. In both cases you can 
supply the phone number ahead of time or leave the num-
ber to the Guest computer.
A callback occurs when one computer attempts to connect 
to another. Instead of completing the connection, Laplink 
reverses the call by hanging up and then dialing the caller’s 

modem. When the caller’s modem answers, the connection 
is completed and service windows are opened.
You can use callbacks as a security measure. For example, 
set callbacks to require a callback to a phone number you 
specify. Or you can use callbacks to save money, as when 
you are connecting to your office from a hotel room.
You can set callback options when you secure your com-
puter using the Log-in List. If necessary, specify a different 
option for each listed entry.
• None Prevents callbacks. (Default)
• Optional, Any Number Lets the guest user decide 

whether to be called back; users who choose to be 
called back can specify the number to dial. This is the 
most flexible of all the options.

• Optional, Specified Number Only Lets the guest 
user decide whether to be called back to the number 
you specify or to open the connection without any call-
back. Only the number you specify in the Phone Num-
ber box can be dialed for the callback.

• Required, Any Number Requires Guest user to be 
called back but allows them to specify the number to be 
dialed. The number can vary from session to session.

• Required, Specified Number Only Requires the 
Guest to be called back to the number you specify in 
the Phone Number field.
CAUTION Do not require callbacks from computers 
that connect by running Xchange Agents. The agents 
will not finish because they cannot perform callbacks.
22
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Laplink will call 
you back at a 
number you 
specify, or will 
disconnect.

Laplink will call 
you back using 
a number you 
enter, or will 
connect with-
out reversing 
the call.

Laplink will call 
you back at a 
number that 
has been 
specified, or 
will connect 
you without 
reversing the 
call.

Laplink will call 
you back at a 
number that 
has been 
specified, or 
will discon-
nect.

Modem Callback window
23
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Local security
The Local Security tab provides another level of security for 
Host machines and those accepting local (cable or infrared) 
connections. Creating password protection for your Laplink 
security settings prevents unauthorized users from compro-
mising your security system; it also keeps them from view-

ing your Address Book entries and using them to open 
connections to other computers. Protecting your security 
settings is a particularly good idea if you allow others to con-
trol your computer as guests.

To enhance security, check Protect Local 
Security with a Password and click the Set 
Password button.

Click to enforce credentials for cable and infra-
red connections to enable local connection 
security.

Local security settings 

NOTE The same password is required 
for access to Connect Over Modem and 
certain logging features.
24
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Without knowledge of your password, users cannot view or 
change any of this information.
• Log-in names, passwords, and other security settings;
• Phone numbers, passwords, and other information 

stored in your Address Book entries;
• Privileges you have granted to Guest computers and 

other settings in Remote Control Options;
• Antivirus options;
• Laplink Internet options.
25
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Encryption
On the Encryption tab, you can choose to encrypt the data 
you send, and choose the encryption method you want to 
use.
Encryption is a good idea over Internet and other connec-
tions where your information might be intercepted and com-

promised. You can use encryption methods provided in 
Laplink, or use the powerful encryption options available in 
the Windows operating system. The settings you make on 
the Host computer determine encryption level for incoming 
connections. By default, Laplink encrypts log-in names and 

Encryption protects the data you are transmiting

Be sure to enable encryption before 
a connection is opened. Changing 
the setting during a connection 
won’t have any effect until the next 
connection.
26
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passwords, but nothing else. This setting is usually fine for 
transmitting data over office networks or other secure con-
nections.
On the Internet, intranets, or wide area networks, however, 
it is usually a good idea to encrypt your data, including files, 
text from chat sessions, and instructions sent to the remote 
computer during Remote Control.

While opening your Host computer to incoming connec-
tions, you can specify if and how data transmitted over 
those connections will be encrypted. The settings on the 
Guest computer are irrelevant. It is the settings on the Host 
computer that determine encryption.

NOTE The only exception occurs when you connect to a 
computer running a version older than Laplink 2000. In this 
case only, the settings on your newer Guest computer deter-
mine encryption levels.

Lockout 
On the Lockout tab, set the number of failed login attempts 
you will accept from any user. When you open your com-
puter to incoming connections, it’s a good idea to include 
Lockout protection so that anyone who supplies an incorrect 
password more than a particular number of times is denied 
access to your computer. 
Like combination safes, security passwords can be compro-
mised. Password crackers use a variety of techniques; 
some techniques are more sophisticated than others, but 
almost all require guessing.
In order to gain access to your computer in Laplink, a 
hacker would also need Laplink installed and running on 
their system, and would need to locate your Laplink Host, 
which is nearly impossible over the Internet. If you are 
using Laplink with a firewall or router, the hacker would 
need to get around that security as well, before they would 
be able to attempt to crack passwords. All of this protec-
tion makes Laplink Gold very secure.However, use Lock-
out as an additional guard against unauthorized access and 
bar anyone who makes repeated attempts at guessing a 
password for entry to your computer.

Monitoring failed login attempts
Lockout is designed to monitor and control access accord-
ing to the login names in your Log-in List. A separate count 
of failed attempts is kept for each login name; when a count 
reaches the maximum you have defined for a specific user, 
that user is locked out and can no longer connect to your 
computer.
Beside the login names listed on the Lockout tab appear 
numbers indicating the maximum number of failed login 
attempts that the account is allowed to accumulate. When a 
count reaches the maximum, the login name is labelled 
Locked Out.
You can reset the count to zero for any or all of the log-in 
names. This action also makes a locked out name usable 
once again.
Unless a log-in name has been labeled Locked Out, its 
count is reset to zero automatically whenever a user con-
nects using that log-in name and the correct password. For 
this reason, only consecutive failed attempts are recorded 
permanently, not cumulative failed attempts.
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Tips for more secure passwords
• Use at least six characters.
• Include letters (both lower case and capitals), numbers, 

punctuation, and symbols.
• Passwords for incoming connections from versions ear-

lier than Laplink 2000 are the exception. They must be all 

capital letters.
• Avoid any words found in dictionaries. (Some pass-

word-cracking programs rely on dictionaries to guess 
passwords.)
TIP Change your passwords at regular intervals.
TIP Don’t make passwords so complex or long that 
you can’t remember them.

Use Lockout to protect 
against someone who 
attempts to guess your 
passwords.
As displayed, Lockout will 
take effect after 18 
(default) failed attempts for 
each log-in name. 

Security Lockout window
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Configuring the Address Book
Laplink Gold’s Address Book offers flexibility and control to users. It allows you to save frequently used 
connections, create folders, organize your connections, and connect directly from the Address Book. 
Advanced features include the ability to import and export connection information to and from a global 
database.

Click the Address 
Book on the Short-
cut Bar.

Address Book main window
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View options and folders 

 The Address Book provides a folder structure and 
other options for viewing connections to computers. 

 Laplink Gold allows you to mark Laplink computers you 
connect to as Favorites when you create address book 
entries. One click on the Favorites icon in the Address Book 
tree lists all users you have marked as Favorites in the pane 
on the right. These might be frequently accessed comput-
ers, VIP’s or other connections you want to keep on your 
Favorite list for easy access. 
Favorites are also displayed in the Shortcut bar.

 Selecting All Users lists all connections you have in 
your entire address book, including all folders and subfold-
ers.

 Choosing Global lists the Global folders. Global folders 
contain connections that may be accessed by many differ-
ent users in your organization. For instance, it might be use-
ful to provide a group of connections to your entire tech 
support team, and another list to your IT team. Global fold-
ers can be shared among your teams using the Import/
Export features, which will be discussed later in this chapter

 Choosing Local lists the Local folders on your system. 
Local folders are used to store connections that you 
wouldn’t need to share with the group. Local folders are not 
affected by importing or exporting.

Renaming, adding & deleting folders
Laplink Gold allows users to the ability to add, rename or 
delete Address Book folders. (Folders will only be changed 

on the machine you are using, not on each Laplink com-
puter.) Laplink folders behave just like folders in Windows or 
Internet Explorer. If you are familiar with how to modify fold-
ers, you can skip this section.

Adding a folder
To add a folder, select where in your address book you’d 
like the new folder to appear. Right-click on the location you 
selected to see your User and Folder options. Choose 
Folder.
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A new folder will appear 
under the Global list 
called New Folder, as 
shown left.

Renaming a folder
To rename a folder, 
right-click on the folder 
you want, and choose 
Rename. 

Type in the new folder 
name in the box. The 
new folder below is 
called Remote Sites. 
Once finished, click 
outside the folder 
name text box to
finish.

Adding a sub-folder

It is just as easy to 
create a sub-folder 
using Laplink Gold. 
Simply highlight the 
folder in which you’d 
like to create a sub-
folder, right-click, then 
choose Folder again.
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Deleting a folder

To delete a folder, 
highlight the folder, 
then right-click to 
view folder options. 
Select Delete to 
remove this folder.

CAUTION Laplink Gold prompts you with the confir-
mation screen below, but it is important to understand 
that deleting a folder will delete the folder and all of its 
contents including any entries in that folder.

Laplink Gold also 
allows you to Cut 
and Paste a folder, 
and any connec-
tions in the selected 
folder. You can 
delete the folder 
from your Address 
Book, or paste it to 
a new location. For 
instance, you might 
have a local folder 
you want to share 
with your entire 
team. 
Tip For Advanced 
users, cut and 

paste this folder from the Local folders to your Global fold-
ers, and export it so that everyone can use the connections. 
Importing/Exporting tasks are explained in detail later in this 
section.
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Address Book window
The Address Book button bar allows control of user func-
tions in the Address Book. Below is a brief description of the 
function of each button.

Close- Exits the user 
from the Address 
Book.

Connect- Connects 
you to the selected 
computer.

Add- Brings up the 
Add User screen.

Edit- Allows you to 
edit a selected entry. 

Delete- Deletes the 
selected entry.

Find- Brings up a 
search interface for 
finding entries.

Setup Global- 
Allows for the import-
ing and exporting of 
a global database.
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Adding an Address Book entry

Description, Company Name and 
Job Title are fields that allow you to 
describe the connection you are mak-
ing. Laplink Gold automatically popu-
lates whatever is typed in the 
Description field to the Computer Name 
field, though it is not necessary for these 
fields to be identical.

TIP When you add an address 
book entry to your Favorites, it 
then appears both in the Address 
Book favorites list and in the 
Laplink Shortcut bar. You can have 
an unlimited number of favorites in 
the Address Book, however, the 
Laplink Shortcut Bar displays up to 
10 entries.

Add Address Book Entry window

Computer Name must exactly match 
the Laplink name of the computer you're 
connecting to and is case-sensitive. 
This is not necessarily the same as the 
Windows computer name. To see or 
change the computer name on the Host 
computer you are connecting to, click 
Options in Laplink on that machine, 
and choose Computer Name.

Security Information to send are the login credentials you have been given to connect to the Host computer. If you do not know 
what this information is, contact the Host’s support administrator.
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Clicking Add on the Address Book toolbar opens the Add 
Address Book Entry screen on the General tab. The 
address book allows you to create and save connections so 
that frequently used connections can be instantly accessed, 
without having to redefine the connection information each 
time. 

NOTE Once these fields contain data, the OK and Con-
nect buttons become enabled, but this does not guar-
antee a connection. Make sure to use the correct 
computer name, and that your connection type is cor-
rect before attempting to make a connection. 
NOTE There are four fields in each entry that must be 
filled in order to save an entry, and for a connection to 
be possible. 

On the General tab
• The Description and Computer Name fields must 

contain characters.
On the Connection tab

• A Connection Type must be selected
On the Services tab

• At least one Service must be selected

Description
This describes the connection you are making. Laplink Gold 
automatically populates whatever is typed in the Description 
field to the Computer Name field, though it is not necessary 
for these fields to be identical. 
If you share this entry, the other fields in the top section 
(Company Name, Job Title, Notes) allow you to further 
describe the connection for everyone who will use it. 

Computer Name
The computer name information entered must exactly 
match the Laplink name of the computer you're connecting 

to and is case-sensitive. This is not necessarily the same as 
the Windows computer name. To see or change the com-
puter name on the host computer you are connecting to, go 
to the Options menu in Laplink on that machine, and 
choose Computer Name. 

NOTE You must close all connections prior to modify-
ing a Laplink computer name.

Security information to send
If you are connecting to a computer that requires you to 
login and use a password, enter these pieces of information 
here. 

NOTE Remember that the password field is case-
sensitive.

Add To Favorites checkbox
Checking this box will allow this entry to be viewed when 
clicking Favorites on the left Address Book pane and in the 
Laplink Shortcut Bar.

NOTE The Laplink Shortcut Bar only displays the first 
10 favorites.
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Address Book - Connection tab
The connection tab allows you to define how you want to 
connect to this computer. Laplink Gold allows many con-
nection options, and these are discussed below. 

 Requirements
Laplink Gold must be 
installed and running on both 
machines. No connection is 
possible, regardless of connec-
tion method, unless Laplink Gold 
is running on both your com-
puter and the Host computer 
Security Must Allow a Con-
nection. 
On the Host computer, security 
must be set to allow a connec-
tion. Otherwise, a connection is 
not possible. To learn more 
about creating secure connec-
tions and host options, See 
“Allowing incoming connec-
tions” on page 16.. 
A Port Must Be Enabled: Each 
connection type has different 
requirements for connection, 
and Laplink Gold requires a port 
to be configured for each con-
nection type. Click Port Setup 
to configure Laplink Gold to use 
your different port options. 

For more information on 
connections see See “Con-
nection Types” on page 37. 
and the online Help system. 
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Connection Types
Laplink allows many different methods to connect to other 
Laplink computers. To learn more about ways of connecting 
using Laplink Gold go to ”See “Types of Connections” on 
page 77.

Network: Available Now
Use this connection type if the computer you are connecting 
to normally appears in the list of available computers when 
you use Connect over LAN (Network).

Network: TCPIP Address
Use this connection type if you want to connect to this com-
puter using a TCPIP address. 

Internet Address (Internet Locator Service)
This connection type uses the address that the host com-
puter has published to the ILS server, such as Jane-
Doe@ACME.com. 

Modem
Use Modem if you use a modem on your machine to con-
nect directly to a modem on the host machine. Simply enter 
in the modem number in the Phone Number fields.

Cable
Laplink Gold accepts use of parallel, serial, or USB cable as 
connection types. 

NOTE It is generally not necessary to create an 
address book entry for cable connections, as Laplink 
Gold automatically creates the connection when the 
cables are attached (by default).

Laplink Internet
Laplink Internet offers great flexibility by also allowing you to 
access other Laplink computers using any Internet connec-
tion. With Laplink Internet you connect directly over the 
Internet to your Host with no firewall or VPN configuration 
required!
Upon installing Laplink Gold 12, you were prompted to cre-
ate a Laplink Internet account. If you did not create an 
account, you can do so at any time. For more information 
see, See “Connecting by Laplink Internet” on page 84. 
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Services tab
The Services tab is where you can define what you'll be 
able to do once your connection is established. You can 
choose as few or as many different services as you need. 

Host Locking on Connect
From the Guest Computer, you can ensure privacy and pre-
vent interruptions at the Host by disabling its keyboard and 

mouse and blanking its screen. Enable the options you 
want to control once you connect by checking the appropri-
ate checkboxes. 
Once you’ve completed your selections on the three 
Address Book tabs, General, Connection and Services, 
click OK to save your changes.

To learn more about any of these services, click 
the links below:

• See “About File Transfer” on page 45.
• See “Laplink Remote Desktop & Laplink 

Remote Control” on page 106.
• See “Using Text Chat” on page 134.
• See “Using Print Redirection” on page 128.

NOTE Host Locking options are only 
enabled when the Remote Control 
service is checked.
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More Address Book toolbar options
The toolbar has several other buttons that allow you to man-
age your Address Book in different ways. 

Connect
Once you’ve created your Address Book entry, click 
Connect to instantly connect you to this computer. This is 
useful for connections you use frequently.

Edit
If you need to change information in a particular Address 
Book entry, select the entry and click Edit to make changes. 

Delete
If you want to delete an entry or a folder from your Address 
Book, choose the entry or folder and click Delete.

Find
Find allows you to search your Address Book for a particu-
lar entry or computer on your system. Search from a partic-

ular folder, or from any of the options on the Address Book 
tree in the left pane. Find searches for computer names 
only.

Using Find
Choose the folder on the left pane you want to search, then 
click Find and enter the computer name you are looking for.
.

CAUTION You 
will see the con-
firmation screen 
to the right, but it 
is important to 
remember that if 
you choose a 
folder, the folder 
and all entries in 
the folder will be 
deleted.
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40

poration you choose (provided Laplink Gold is installed on 
their desktop). This makes it easy to create a single address 
book and share it with your tech support or IT teams
.

NOTE If Laplink Gold is not able to 
locate this computer in the selected 
folder, it will ask you whether you’d 
like to look through the rest of the 
Address Book to find it.

At this point, Laplink Gold will search 
the rest of the Computer Names in the 
Address Book for the name or name 
segment you entered, and provide you 
all matches.

Find Address window
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Laplink Gold uses Microsoft’s Data Link Properties utility to step 
you through the process of connecting to your database. If you 
have questions about creating this connection, please consult 
your company’s database administrator.

Setup Global
For advanced users such as IT professionals, Laplink Gold provides the ability to link to a SQL database through the 
Address Book. This allows you to create a Global Address book and share this Address Book with anyone in your corpo-
ration you choose (provided Laplink Gold is installed on their desktop). This makes it easy to create a single address 
book and share it with your tech support or IT teams

Click Setup Global. The Import/Export 
window appears. Laplink Gold requires a 
connection to an SQL database through an 
ADO string. If you or your administrator 
know this information, then enter it on the 
left. Alternately click the Build Ado button, 
which will bring up the Windows Data Link 
Properties screen.
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Importing
Importing allows you to download a local copy of the Global 
Address book. As the Address Book is updated, users may 

Importing and 
Exporting ONLY 
affect the Global fold-
ers.

Connections in your 
Local folder can’t be 
shared.

To share Local 
addresses, copy 
them from your Local 
folders to your Global 
folders, and then 
share these connec-
tions using Import/
Export.

Once you’ve clicked the Build 
ADO button and established a 
connection to your database, 
your Import/Export buttons are 
enabled.

To prevent your Global Address book from 
being inadvertently overwritten, keep one 
source copy to make changes, then export that 
copy to Laplink Gold users.

Importing and Exporting
Importing and Exporting allows you to share Global Address entries
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add or delete users or folders. Importing allows you get any 
new folders and entries made in your Address Book.

NOTE To import, you must have read access privileges 
to the database. See your database administrator for 
more information.

Exporting
Exporting allows you the capability of making changes to 
your Address Book, then Exporting those changes to the 
database. Exporting is primarily an administrative function. 

NOTE If you’ve made changes to your Global Address 
list, and you want to share these changes with other 
Laplink Gold users, you must first use Export to send 

those changes back to the main database before other 
Laplink Gold users can Import the changes.
CAUTION If you make changes to your Global 
Address Book and then click Export, those changes 
are permanent, both in your Address Book, and in any-
one’s Address Book who later imports it.
CAUTION Exporting requires write privileges. Data-
base administrators should carefully manage which 
users have Address Book exporting capabilities. 

Help
Click Help to obtain more information on all of Address 
Book components. 
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About File Transfer
If you have more than one computer, or if you share data with others, you know how challenging it can 
be to make sure you have the most recent information and to keep your data synchronized. With File 
Transfer you can quickly move and synchronize files and folders; it streamlines the process of managing 
your data. With Laplink Gold you can drag and drop files, or use SyncTools to manage your data. 

You can transfer or synchronize files and folders by dragging and dropping the entire contents, using 
SmartXchange to update only the newest files, or creating Xchange Agents to manage synchronization. 
You can manually transfer files and folders, or setup Laplink to do it for you automatically. 
45



 Laplink Gold 12
File Transfer windows can be opened between a Guest and 
Host computer or you can use File Transfer to update files 
on the same computer.
Navigate File Transfer windows the same way you navigate 
in Microsoft Windows Explorer. If you are unfamiliar with 
Microsoft Windows file navigation see ”Navigating through 
drives and folders” on page 71.

File transfer terms 
Source: The selected file or folder. 
Target: The destination folder into which you are transfer-
ring data.
To open File Transfer windows:
For step procedures on how to configure and use the File 
Transfer service and Sync Tools, see the on-line Help sys-
tem.
• Connect to another computer with the File Transfer ser-

vice selected, or click the File Transfer button on the 
Shortcut bar. 

TIP If you want to transfer files within your computer, 
open a File Transfer session when you do not have a 
connection to a Host.

• Two File Transfer windows appear: one for the Host 
computer, one for your computer. Using these win-
dows, you can view all the files on any drive on both 
computers.

Security settings on the Host determine which folders you 
have access to.
The name of each computer appears in the title bar. The 
Guest computer appears on the left and the Host computer 
on the right.
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Configuring File Transfer Options
Certain File Transfer options play a crucial role when you are copying or moving files. Depending on 
how you set them, you can include or exclude subfolders, prevent the overwriting of files except by newer 
copies, or copy only files you have backed up before. Before you confirm a copy or move operation, you 
can change the settings for that operation.

To open File Transfer options window from the main menu, 
select Options, and then File Transfer Options.

Copy/Move tab
On the Copy/Move tab, enable or disable File Transfer 
recovery and choose which verification messages you want 
displayed. 

File Transfer Recovery - Overview
If you lose your connection to another computer while trans-
ferring files, File Transfer Recovery lets you connect again 
and continue the transfer where it left off. Any file—or portion 
of a file—copied before the interruption is skipped; only the 
untransmitted data is copied.

If you lose a connection while 
transferring a file, the data 
transferred at the point of inter-
ruption is stored on the target 
computer.

When you reconnect and 
resume the transfer, the miss-
ing part of the file—not the 
entire file—is copied, along with 
the remaining files.

File Transfer Recovery is set on the Copy/Move tab of File Transfer Options.
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File Transfer Recovery lets you resume a file transfer when 
you have lost a connection. Instead of starting the transfer 
at the beginning, File Transfer Recovery resumes at the 
point where the connection was lost:
• Only the missing part of the interrupted file is copied.
• Files successfully copied before the interruption are not 

copied again.
TIP File Transfer Recovery is particularly useful when 
you copy large files over an unreliable modem connec-
tion.

To resume an interrupted file transfer:
• If you were running an Xchange Agent when the inter-

ruption occurred, run the agent again.
• If you were transferring from File Transfer windows:

1 Re-establish the connection.
2 Select the same files and folders.
3 Begin the transfer again.

Configuring File Transfer Recovery 
Three options must be enabled for File Transfer Recovery 
to work effectively. All three appear on File Transfer Options 
window and are enabled by default.
• Enable File Transfer Recovery. Located on the Copy/

Move tab, this box must be checked for File Transfer 
Recovery to occur. See “Copy/Move tab” on page 47.

• Use SpeedSync on All File Transfers. Located on the 
Performance tab, this box must be checked to allow 

the transfer to resume with the missing part of a file. 
When it is cleared, the entire file must be sent again. 
See “Using SpeedSync” on page 51. 

• Transfer Only If Files Are Newer
• Located on the Filter tab, this box must be checked so 

that files successfully copied before the interruption are 
not copied again. See “Filter tab” on page 49.

When a transfer is interrupted, File Transfer Recovery cre-
ates a file in the target folder containing whatever part of the 
file has been transferred successfully. The file is named 
Laplink.TSI.
When File Transfer Recovery resumes a transfer, this file is 
compared with the source file to determine what’s missing. 
Once the file is complete, Laplink.TSI is given its original 
name. (If you do not use File Transfer Recovery to resume 
the transfer, the file remains in the folder and can be safely-
deleted.

Delete tab
The Delete tab you determine how you want deleted data 
to be handled. By default, any files you delete from a hard 
drive are recycled, that is, moved to the Windows Recycle 
Bin where you can retrieve them later.

NOTE Whether files are recycled or permanently 
removed is determined solely by the settings on the 
Guest computer.
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Filter tab
Filter Options are accessible by clicking Options, and then 
File Transfer Options. Click the Filter Tab and from within 
File Transfer, click confirmation dialog boxes.

Set options on the File Transfer Options Filter 
tab. These become your default settings. 
You can modify the default setting easily each 
time you transfer files. Confirm the settings, 
then click OK to continue.
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There are three File Transfer options that determine which 
files are transferred and which are overwritten:
• Transfer Only If Files Are Newer
• Include Subfolders in Copies
• Transfer Only If Files Are Already on Target
The first two options are in effect until you change them.
To change your default preferences for Filter options:
• Select Options, and then File Transfer Options. Click 

the Filter tab and then check the appropriate boxes.
For step procedures, see the online help system.

The options on the Filter tab set the default settings to han-
dle file transfers. You can configure these options for each 
file transfer you perform.

CAUTION Before transferring files between comput-
ers, ensure that their clocks are synchronized. If they 
are not, files that appear to be older may actually be 
newer, and you could lose your most recent work.

Protecting newer copies of files
Transfer Only If Files Are Newer is designed to preserve 
files that represent your most recent work. It is also useful 
for speeding up file transfers; files that do not need to be 
updated are excluded from the operation.
When the box is checked, Transfer Only If Files Are 
Newer ensures that files are not overwritten by older copies 
of those files. (Files not already on the target will be copied 
anyway.) When the box is cleared, files are overwritten with-
out regard to their dates and times.
This must be enabled in order to use File Transfer Recov-
ery. See “File Transfer Recovery - Overview” on page 47.

Including or excluding subfolders
Include Subfolders in Copies is designed for copying a 
hierarchy of folders and subfolders. It can make the differ-
ence between copying hundreds of files or only a few.
When the box is checked, Include Subfolders in Copies 
extends your selection to include any subfolders within the 
folders you have selected. When the box is cleared, your 
selection is limited to the selected files and folders (including 
the files in those folders). Subfolders within folders are 
excluded.

Updating older copies of files
Transfer Only If Files Are Already on Target simplifies 
the task of updating older copies of files without adding new 
ones. It is designed for anyone who regularly updates the 
same set of files. No matter how many files you select on 
the source, only those already on the target will be copied; 
the others will be ignored.
In preparation for using this option the first time, copy the 
files to the target with the box cleared. When you are ready 
to update the same files, check the box.

Performance tab
To improve performance (speed) of file transfers you can 
configure each transfer to use Laplink’s SpeedSync and 
Compression. For detailed information on SpeedSync, see 
”SpeedSync and Compression” on page 51.

Display tab
On the Display tab you determine how you want new file 
transfer windows to be displayed, and if SmartXchange sta-
tistics are displayed. See ”SmartXchange” on page 58 for 
more information on SmartXchange. 
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SpeedSync and Compression
When you are updating files, SpeedSync can shorten trans-
fer times by sending only the parts of the files that have 
changed since the last update. SpeedSync is most effective 
when you update files that have not been changed exten-
sively since the last update. Compression speeds file trans-
fers by “shrinking” files before they are sent and restoring 

them to their original sizes afterward. Compression is most 
effective with large files that have not been compressed 
already. Though both features are in effect by default, there 
may be circumstances in which you might improve transfer 
times by disabling them.

Using SpeedSync
To enable or disable SpeedSync, select Options, and then 
File Transfer Options. Click the Performance tab.
SpeedSync is designed to cut transfer times when you are 
updating files. It has no effect when you are copying files 
that were not on the target before you started copying.
Before a file is copied, SpeedSync searches the target for a 
file with the same name. If none is found, the entire file is 

copied. Otherwise, the two files are compared to locate 
changes in the source file. Only the changes located in the 
source file are copied.
The time necessary to locate changes is usually more than 
offset by the smaller amount of data that has to be trans-
ferred. The reverse may be true in a few circumstances, 
e.g.; when you are updating many small files over a fast 
connection.

With SpeedSync
Source and target files are com-
pared to locate changes in the 
source file.
Only the changes are copied, result-
ing in faster transfers.

Without SpeedSync
Source and target files are not com-
pared for changes.
Entire files are copied, often resulting 
in longer transfer times.
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SpeedSync is a tool for decreasing transfer times. It does 
not merge the contents of two files. The contents of one file 
will always replace the contents of the other. If you need to 
merge databases, schedules, or other shared files, see the 
documentation for the program in which they were created.

Using compression
To enable or disable Compression click Options, and then 
File Transfer Options. Click the Performance tab.

Because compression usually results in the transfer of less 
data, it is particularly useful when you transfer large files by 
modem: the larger the files, the greater the savings.
Since compression would actually slow the transfer of files 
that have already been compressed (or zipped by another 
file-compression program), Laplink automatically turns this 
feature off while it is transferring such files.

NOTE Whether SpeedSync and Compression are 
used, in file transfers depends entirely on the settings of 
the Guest computer.
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Antivirus options
To enable or disable Antivirus scanning, click Options, and 
then Antivirus Options. 
Laplink’s new integrated Antivirus feature keeps your Guest 
and Host computers safe from computer virus infection by 

checking all incoming and outgoing files with a powerful 
virus scanning engine. Automatic updates keep your com-
puters safe while you can configure preferences let you 
determine the level of protection you need.

To configure your antivirus settings click 
Options, and then Antivirus Options.

Antivirus protection is enabled by default.

You can select to automatically delete 
infected files, or Quarantine them 
(default) for your review.

Antivirus options allow you to select the 
file types you want scanned. 

Click the Update button to get the most 
recent antivirus signature. 
NOTE: Laplink Antivirus updates are 
included for the first year of service, at no 
additional cost.

By default, when you start Laplink it 
checks for antivirus updates automati-
cally.
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Manually Transferring Files & Folders
With Laplink you can easily drag and drop or copy and move items to update the contents of your 
folders, or you can synchronize the contents by comparing files, and updating folder pairs with the most 
up-to-date information. Laplink folders work the same as Microsoft Windows Explorer folders so that you 
quickly transfer files using the familiar interface.

Drag and Drop

Select then drag and drop items 
from one computer to the other.

Select several items not listed 
together by holding down CTRL 
while clicking the items.
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Copy or Move
Once you have displayed the target and selected the items 
to be transferred, you are ready to use the Copy or Move 
command, or you can use the mouse to drag the items and 
drop them onto the target. Before the transfer is started, you 
see a confirmation dialog box showing details of the opera-

tion you are about to perform. You can then proceed imme-
diately, change certain conditions, or cancel the operation 
entirely.
You must select a folder or file before you can copy or move 
it. When you select an item, its name and icon are high-
lighted.

NOTE By default, selecting a folder selects all of its files 
and its subfolders. See “Filter tab” on page 49. You can 
modify this option for each transfer.

When you copy or move, you transfer items from one loca-
tion (the source) to another (the target). You can transfer 

items using the Copy or Move commands or by dragging 
them with the mouse.
• Dropping selections onto a drive puts the selections at 

the highest level of the folder hierarchy.
• Dropping selections onto a folder puts the selections 

inside the folder.
• Dropping selections onto a file puts the selections on 

the same level as the file.

Use Copy to copy a file from one folder to another. Use Move to move a file from one folder 
to another. Move will delete the file from its source location

To assist you in finding a specific file use 
Select By to enter search criteria.

Use Select All to select the entire contents of a folder. 
You cannot use File Transfer to select the contents of your root directory.

If you want to know the total size of the 
files being transferred, highlight those 
files and choose SIze of Selections.

TIP To drag and drop,
• Hold down Shift when moving 

a file
• When copying local-local, hold 

down CTRL to copy.
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SyncTools
Laplink’s SyncTools allow you to enhance performance and manage synchronization of your data. You 
can easily synchronize once, or set up Xchange Agents for data that you frequently synchronize. You can 
even schedule synchronization to occur automatically.

Clone Folder
Clone Folder replicates one folder (the source) onto another 
(the target) by adding, deleting, and updating files on the 
target until they match those on the source. After opening 
the target and the source folders, click SyncTools, and 
then Clone Folder. Then choose whether to include or 
exclude subfolders.
The effect is the same as deleting everything on the target 
and copying everything from the source.

Cloning a folder adds and updates target files until they are 
identical to those on the source. In addition, it deletes any 
target file that is not on the source.

NOTE With Clone Folder, you determine the items to 
be copied by selecting the folder containing the items, 
not by selecting the items themselves.

Clone Folder — replicates one folder onto another.

Smart Xchange — synchronize two folders in a two-way 
exchange of files.

Xchange Agent — takes the function of SmartXchange to 
a higher level by automating synchronization.
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.

It’s the deletion of files that makes Clone Folder useful, par-
ticularly when you are maintaining a backup folder. With the 
usual copy operation, the backup folder over time accumu-
lates all the files you have deleted from the source. With 

Clone Folder, those unwanted files are removed with each 
backup.

CAUTION Use this command with caution. Any sub-
folder or file not on the source will be deleted from the 
target.

Source Target

Use Clone Folder to replace the con-
tents of one folder (the target) with 
the contents of another (the source).
Clone Folder has the effect of eras-
ing the target and copying the entire 
source.

CAUTION This is the ONLY 
synchronization function of 
Laplink Gold that allows data 
deletion. Since this function 
cannot be undone, consider 
carefully before using Clone 
Folder. 
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SmartXchange

Use SmartXchange to synchronize two folders in a two-way exchange of files. You can limit the scope of 
the operation by including only the files already in both folders. You can also use SmartXchange to 
update a backup folder quickly. In either case, older files are overwritten, but no files are deleted.

Synchronizing folders
If you have ever copied files back and forth between com-
puters so that they share the latest files, you have synchro-
nized. Unlike the usual copy operation, Laplink 
SmartXchange synchronization works in two directions: 
from one folder to the other and back again.

NOTE With SmartXchange, you determine the items to 
be copied by selecting the folder containing the items, 
not by selecting the items themselves. 

With SmartXchange, you can accomplish this in one opera-
tion, one folder at a time. You can increase the scope of the 
operation by including subfolders within the folder. You can 
limit its scope by exchanging only the files that are on both 
folders already.

NOTE SmartXchange is a tool for exchanging files 
between folders. It does not merge the contents of files. 
If you need to merge databases, schedules, or other 
shared files, see the documentation for the program in 
which they were created.

Files are overwritten when there are 
newer copies in the other folder.

In SmartXchange

Files are not copied when there are 
identical copies in both folders.

Files are copied when they are in 
one folder but not the other.

After SmartXchange, the two folders 
are identical.
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Tips on using SmartXchange:
For step-by-step instructions on using SmartXchange, see 
the on-line Help files.
• If you synchronize the same folders on a routine basis, 

consider using Xchange Agent instead of SmartX-
change. See “Customizing an Xchange Agent” on 
page 66.

• To verify which folder is open, look at the title bar, at the 
top of the File Transfer window.

• Laplink cannot synchronize an entire drive, the folders 
containing the Windows operating system, or any other 
data that is locked (in use).

• Any files that you intentionally delete on one computer 
will be automatically replaced by two-way synchroniza-

tion. If you wish to use a two-way transfer, you must 
manually delete the files in question on both computers 
before running the SmartXchange. For more informa-
tion on deleting data, see page 56.

• If you want to include subfolders in the exchange, 
check Include Subfolders when prompted.

• If you want to update files and not add new ones, check 
Transfer Only If Files Are Already on Target when 
prompted.

• Make sure that One-way Transfer Only is NOT 
selected, unless you are performing a backup of data.
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Xchange Agents
Xchange Agents automate and save the functionality of SmartXchange. To set up an Xchange Agent, 
open a connection to another computer, choose the pairs of folders to be synchronized; then preview and 
perform the synchronization. After working on files in either computer, run the saved agent to reconnect 
and update the older copies of the files automatically. You can run an agent by double-clicking its shortcut 
icon or by scheduling it to run unattended.

Xchange Agent simplifies the repetitive process of keeping 
two computers in sync. Whether your most recent work 
appears on one or both of the computers, Xchange Agent 
transfers files so that both have only the newer copies of 
your files.
Xchange Agent automates the process of opening connec-
tions, selecting the pairs of folders to be synchronized, set-

ting the appropriate options, initiating the exchange, and 
disconnecting. To prevent unwanted results, you can pre-
view beforehand.

TIP Xchange Agent is also useful for local synchroni-
zations, as when you keep files on your desktop syn-
chronized with files on a local network.

Xchange Agent automatically copies the newer versions of all 
files regardless of which computer they are on. Files that have 
no match are copied onto the computer that lacks them.

Files in the synchronized folders are 
identical.
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Creating an Xchange Agent
Once you connect to another computer, you create an 
Xchange Agent by selecting the pairs of folders—one folder 
on each computer—which you want to keep synchronized. 
You can select the pairs from a window displaying the fold-

ers on both computers, or you can drag folders from File 
Transfer windows onto the Xchange Agent window. In 
either case, you can preview the agent to ensure that you 
have set up the synchronizations as intended.

Xchange Agent wizard
The wizard guides you through the process of selecting 
pairs of folders to be synchronized. After naming and saving 
the agent file, you can preview the agent and change its set-
tings.
To make the files in each folder pair identical, click the Run 
button on the toolbar.

NOTE There are two modes in Xchange Agent: edit 
and preview. Certain operations are available in one 
mode and not the other. To save an agent, for example, 
you must be in edit mode. To change to edit mode from 
preview mode, click the Close Preview button on the 
toolbar.
61



 Laplink Gold 12
New Xchange Agents
Choose SyncTools > New Xchange Agent and select the 
pairs of folders to be synchronized.
• On the Edit menu, click Add Folder Pair. After specify-

ing whether the synchronization is Local-Local or 
Local-Remote, click a folder on each side of the win-
dow. Repeat the procedure to add other folder pairs.

• Drag folders from File Transfer windows onto the 
Xchange Agent window. Drag a folder first from one 

File Transfer window, then from the other one. Repeat 
the procedure to add other folder pairs.

Once you have selected the pairs to be synchronized, you 
can do any of the following:
• Preview the agent: click Preview.
• Name and save the agent file: On the File menu, click 

Save. In the File Name box, type a name, and click 
OK.

• Run the agent to make the files in each folder pair iden-
tical: click Run on the toolbar.
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Previewing and running an Xchange Agent
Previewing an Xchange Agent lets you see exactly which 
folders will be synchronized and which files will be overwrit-
ten. It also lets you skip pairs of folders and files and resolve 
conflicts. Unless you specify otherwise, you preview each 

agent before you run it. You can run an agent from the Win-
dows desktop, from within Laplink, or you can schedule it to 
run in your absence.

Previewing
By default, a preview appears whenever you run Xchange 
Agents. You can also open an agent and preview it.

NOTE By default, only agents that you schedule to run 
unattended will proceed without a preview. To set up 
agents to run without a preview, see page 67.

While previewing an agent you can do any of the following:
• Select files or folders to be omitted from the current 

synchronization only Click a pair and click the Skip 

Pair button on the toolbar. Skipping a folder skips all the 
files and subfolders it contains.

• Put skipped pairs back into a synchronization
Click a skipped pair and then click Undo Skip on the 
toolbar.

• Resolve conflicts Click a pair showing a conflict 
icon, click Resolve Conflict, and specify how you want 
the conflict resolved. For more information about resolv-
ing conflicts, see page 65.
NOTE In a preview, arrows indicate the direction in 
which files will be copied, and thus which files will be 

While previewing an Xchange Agent, you can 
tell the direction of copy from the arrows.

When both files have been modified since a previous synchronization. 
You can specify how these “conflicts” are handled.
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overwritten. Special icons indicate conflicts between 
files.

• To select every pair of folders and files in the agent, 
click Edit, and then Select All.

• To locate a pair with a conflict, click the Next Conflict 
button on the toolbar.
CAUTION Once you have resolved conflicts or 
marked pairs to be skipped, run the agent before clos-
ing the preview. Your modifications will be lost other-
wise.

To close a preview:
• Click Close Preview on the toolbar. You are now in edit 

mode.
TIP While in edit mode you can customize an agent in 
several ways. For more information see page 66.

Running an Xchange Agent
There are several ways to run a saved Xchange Agent:
• Double-click the agent’s shortcut icon on the desktop. 

To create a shortcut icon for an open agent, click Cre-
ate Desktop Shortcut on the File menu.

• Schedule the agent to run at an appointed time. For 
more information see page 69.

• Run the agent from within Laplink. Click Run Xchange 
Agent on the SyncTools menu. Then click the name of 
the agent file and click Open.

• Run an agent you have opened in Xchange Agent. 
Click the Run button on the toolbar.

• In Windows Explorer, double-click the agent file. By 
default, agent files have .LLX extensions, and are 
saved to the My Documents folder.

Once an agent finishes synchronizing files, the connection 
to the Host computer is closed. If Laplink was not running to 
begin with on the Guest computer, it is shut down automati-
cally.

TIP For a record of your latest synchronizations, refer 
to the Laplink log file located by clicking Options, and 
then Logging.
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Dealing with conflicts
When you are keeping folders on two computers in sync, a 
conflict occurs when a file has been modified on both com-
puters since the last time you synchronized. You can han-
dle these conflicts when you preview or run the agent, or 
you can set options to handle them automatically.

Conflicts between files
Conflicts occur when you modify a file on both of your com-
puters. Since both files are new, you need to decide how to 
handle them:
• Copy either the older or the newer file to the other 

folder, replacing the file already in that folder;
• Copy either the older or the newer file to the other folder 

and give the file a new name. Nothing is replaced;
• Skip the conflict without copying either file.
When you skip a conflict you carry it over to future synchro-
nizations. There are two categories of conflicts:
• New conflicts Files have been changed on both 

computers since the previous synchronization;
• Old conflicts Conflicts were left unresolved in earlier 

synchronizations. The two computers now have differ-
ent versions of the same file, and both are dated prior to 
the latest synchronization. You can either treat these 
conflicts as new conflicts or ignore them and let both 
versions remain.

Changing how all conflicts are handled  By default, 
each conflict is presented for resolution when you run an 
Xchange Agent. You can change this so that conflicts are 
handled automatically.You can modify the conflict setting 
from the Xchange Agent’s Properties tab. 
Ignoring old conflicts  By default, old and new conflicts 
are treated alike, according to the settings on the Xchange 

Agent Properties > Run Options tab. For example, if you 
specify that conflicts are to be displayed every time you run 
an agent, old conflicts will appear every time you run the 
agent. The alternative is to exclude old conflicts, regardless 
of how other conflicts are handled.

NOTE To retain both versions of files in old conflicts, 
click this option on the Advanced tab in Properties: 
Exclude Previously Skipped Files.

Other conflicts
You may encounter other kinds of conflicts in these situa-
tions:
• When you attempt to copy a file or folder with a long 

name to a drive that does not accept long names;
• When you attempt to synchronize a file with a folder; 

this happens only when a file and a folder have exactly 
the same name.

Long name conflicts  If you do not shorten long names, 
you are given this choice when you run an agent: either 
copy the file and give the copy a short name, or skip the 
conflict without copying the file.
Conflicts between files and folders  If you do not 
rename the file to avoid the conflict, you are given this 
choice when you run an agent: either copy both the file and 
folder and give the copies new names, or skip the conflict 
without copying either.
The best way to handle either of these conflicts is to rename 
files: shorten the long names or rename the file so that it 
does not conflict with the name of the folder. True synchro-
nization cannot occur otherwise. If you set an agent to run 
unattended, for example, neither file in a conflict is copied.
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Customizing an Xchange Agent
Instead of a two-way synchronization, you can customize 
an agent so that files within folder pairs are copied in one 
direction only, from one computer to the other. Among other 
modifications, you can create a shortcut icon to run an 

agent directly from the desktop, run an agent without a pre-
view, and limit synchronizations just to the files that already 
appear on both computers.

To customize an agent, you must open it from within Laplink 
or Xchange Agent.
• Select SyncTools and then Open Xchange Agent. 

Click the agent file and then click Open.
OR

• In Xchange Agent, select File, and then click Open 
Xchange Agent. Click the agent file and then click 
Open.

Changing the direction of copy
When you create an Xchange Agent, all folder pairs are set 
for a two-way exchange of files. Files are copied in both 
directions until the folders on both computers are identical.
You can modify this by specifying that files in a folder pair be 
copied in one direction only, so that only one folder updates 
the other.

NOTE To customize an agent, you must be in edit 
mode. If you are previewing, click the Close Preview 
button on the toolbar.

Direction—To 
change the direc-
tion of the copy first 
click one or more of 
the folders.

Add Pair— Add 
another folder 
pair to this 
Xchange Agent.

Preview—Dis-
plays what actions 
the agent will per-
form.

Run—
Starts the 
Agent.
66



 Laplink Gold 12
Adding folder pairs
With the Agent open, click the Add Pair icon in on the main 
menu. 
To delete a pair of folders, click the pair and click Delete 
Pair(s) on the Edit menu. Then click Yes. The folders are 
deleted from the agent, not from the computers.

Changing how an Xchange Agent is 
run
There are several ways to customize how an agent is run:
• Create a shortcut icon for running an agent from the 

desktop: on the File menu, click Create Desktop 
Shortcut.

• Schedule the agent to run at the time you want: Select 
File, and then Schedule. For more information see 
page 69.

• Set up the agent to run unattended: Click File, and 
then Properties. Then click Run Options tab, and 
then Run Unattended without Preview or Confirma-
tions. Determine how conflicts will be handled by click-
ing either of these options: a.) Copy the Newer File 
over the Older or b.) Do Not Copy Either; Keep Both 
Files.

Changing which files are included in 
synchronizations
By default, subfolders within folder pairs are included in syn-
chronizations. Read-only files are also included, but hidden 
files and system files are not. To change these settings, 
click File, and then Properties. Click File Options tab and 
change the settings as necessary.
With File Options tab, you can set an option to limit syn-
chronizations by exchanging only files that already appear 
on both computers. To exclude files that have been added 
to one computer and not the other, check the box: Include 
Files Only If They Are Present in Both Folders.

NOTE Filters offer another way of determining which 
files are included in synchronizations. For more infor-
mation, see page 68.
TIP Instead of changing the various options every time 
you create a new agent, you can set default options to 
apply to any agents you create in the future. These 
defaults will take effect in new agents unless you spec-
ify otherwise in Properties. To change the defaults, click 
Options, and then Properties for New Agents.
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Using filters to include or exclude files
Using preset filters or filters you create yourself, you can 
limit synchronizations by including only certain files or types 

of files. Or you can use the same filters to exclude files and 
file types.

Xchange Agent includes filters for some of the most com-
mon types of files, including Microsoft Office file types, Lotus 
1-2-3, and dBase. File types are defined by one or more 
extensions. Word files, for example, are defined by the 
extensions .DOC and .DOT.

You can also create your own filters for different file types—
or for specific files.
You can use filters to synchronize only the files matching 
the filters. Or you can exclude the files matching the filters 
and synchronize the rest of the files.

Click a filter in the list of 
available filters. Then click 
the Add button.

By default, filters limit syn-
chronization to files that 
match the filters.
If you prefer, you can use 
filters to exclude matching 
files—and synchronize the 
rest.
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Scheduling an Xchange Agent to run automatically
You can schedule an Xchange Agent to run at a certain 
time on the days you specify. Scheduled agents can be 
configured to run unattended: there is no preview, and con-
flicts are handled automatically. Xchange agents can be 

scheduled using the Laplink Schedule Wizard. To run the 
agent on schedule, simply leave the scheduler running on 
the Guest computer.

You can set up an Xchange Agent to run at a particular time 
on one of these schedules:
• Just once, on a particular date.
• Every day
• On certain days of the week (such as Monday and Fri-

day)

• Once a month on a particular day (such as the first day 
of each month)

Laplink does not have to be running on the Guest computer 
for an agent to run as scheduled. When the scheduled time 
comes, Laplink starts, the connection is opened, files are 
synchronized, the connection is closed, and Laplink shuts 
down.

You can schedule an 
Xchange Agent to run 
unattended.
When the scheduled 
time comes, Laplink 
starts, the connection is 
opened, files are syn-
chronized, the connec-
tion is closed, and 
Laplink shuts down.
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Laplink prepares an Xchange Agent to run on schedule by 
setting it up in the Laplink scheduler program.

NOTE You can also use the Windows Task Scheduler 
included in Windows 98, ME, 2000, XP, and 2003. For 
more information, consult your Windows documenta-
tion.

Running an agent unattended
A scheduled agent runs without preview, even if you have 
specified preview on the Run Options tab of Properties.

When conflicts are encountered, they are ignored; neither 
file is copied. If you prefer to have the newer file in each 
conflict copied over the older one, 
Click File, and then Properties. In Run Options, click Run 
Options tab, and then Run Unattended, without Preview 
or Confirmations. Then click Copy the Newer File over 
the Older.

TIP To ensure that an agent runs and synchronizes as 
scheduled, the agent should originally be created while 
connected to the host via an Address Book entry. This 
stores the log-in name and password required by the 
Guest computer to open the connection.
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Navigating through drives and folders
Each File Transfer window is split into a left and a right side. The left side is designed for navigating 
through drives and folders: click or double-click a drive or folder to open it and display its contents. On the 
right side, you see the contents of the open drive and folder. Commands on the View menu let you 
change the appearance and the order of the contents.

Click a drive or folder to open it, with-
out showing its contents.

Click a plus sign to show the con-
tents of a drive or folder without 
opening it. Click a minus sign to hide 
the contents.

Double-click a drive or folder to open 
it and show its contents.
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Follow these guidelines to navigate through the left side of a 
File Transfer window:
• Double-click a drive or folder Opens and expands 

the drive or folder, displaying its subfolders immediately 
below. (Double-clicking is the fastest way to navigate 
downward in a hierarchy of folders.)

• Click a drive or folder Opens the drive or folder with-
out expanding it.

• Click a plus sign (+) Expands the drive or folder, dis-
playing its subfolders immediately below. The drive or 
folder is not opened.

• Click a minus sign (-) Collapses the drive or folder, 
hiding its subfolders.
TIP Want to locate a particular folder or file? Type the 
first letter of its name. The highlight moves to the next 
item beginning with that letter. Typing the letter again 
finds the next occurrence.

Changing the view
When you open a drive or folder, you see its contents—sub-
folders and files—on the right side of the File Transfer win-
dow.
By default, the contents appear in Detail view: file name, 
size, type (based on the MS-DOS name extension), modifi-
cation date, and attributes.
To change the appearance of the items displayed on 
the right side of a File Transfer window:
• On the View menu, click one of these commands: 

Large Icons, Small Icons, or List.
Try the different views to find your preference. To return to 
the original view, click Detail.

Sorting files and folders
Regardless of the view, you can rearrange the folders and 
files on the right side of a File Transfer window according to 
name, size, date, and so on.
To change the order of files and folders:
• On the View menu, point to Arrange Icons; then click 

one of these commands: By Name, By Type, By Size, 
By Date, or By Attributes.

If you are displaying files in Detail view, you can sort them 
by name, size, type (file name extension), modification date, 
or attribute: click the corresponding button at the top of a 
column. Clicking the same button again reverses the order.

Step one: display the target
To use the drag-and-drop method of copying and moving 
files, first find your target and make it visible on your screen. 
A target is the drive or folder you want to transfer the files to.
To display the target:
1 Identify the target window: it may be the window for your 

computer or the Guest computer—whichever you want 
to receive the files.

2 On the left side of the target window, double-click the target 
drive.

3 Click the target folder. Its contents now appear on the right.
4 If you are looking for a subfolder, click the plus sign (+) 

beside the folder containing the subfolder. Then click the 
subfolder itself.
NOTE To determine which File Transfer window is 
which, look for the computer name in the title bar, at the 
top of each window. In the case of a local-to-local con-
nection, each window will show the same name, fol-
lowed by a (1) or (2).
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Step two: select the files
In the opposite File Transfer window, select the files you’ll 
be transferring to the target you just displayed.
To select the folders and files you want to transfer:
• On the right side of the window, click the folder or file 

you want to transfer.
• To select more than one item, do either of the following:

• Hold down CTRL as you click each item.
• To select two or more items listed next to each other, 

click the first item and press SHIFT while you click 
the last item.

Step three: drag and drop
Using the drag-and-drop method simplifies file transfers. 
Keep in mind the difference between copying and moving: 
Copying puts a copy of the files on the other computer, 
leaving the originals where they were. Moving puts the files 
on the other computer, deleting the originals.
To drag and drop the selected files:
• To copy the files, hold down CTRL and your left mouse 

button as you drag them to the target folder.
• To move the files, hold down SHIFT and your left 

mouse button as you drag them to the target folder.
If you drag without using CTRL or SHIFT, files are copied 
when you drag to a different drive or computer and moved 
when you drag to another location on the same drive.

To select a single file or folder:
• Place the mouse pointer on its name or icon, and click 

the left mouse button.
To select a group of items, do either of the following:
• Click the first item, and press SHIFT while you click the 

last item.
• Click at a right corner of the group and drag to the 

opposite corner to form a selection box.
To select two or more items out of sequence:
• Press CTRL while you click the items.
To select all folders and files in the current folder:
•  On the File menu, click Select All.
Using the Select By command for files and folders:
1 On the File menu, click Select By.
2 In the Filter box, type the name of a file or folder. Or use 

wildcards to specify items with similar names.
For example, typing *.DOC selects all files with the .DOC 
extension. The default (*.*) selects all files and folders.
You can specify several criteria at once by typing them 
one after another and inserting a space or a comma 
between them. For example, typing *.DOC,*.TXT dis-
plays all files with those extensions.

3 If you want to select according to date, check the Enable 
Date/Time Range box. Then type the dates and times 
under Oldest File and Newest File. Click OK.

Clearing selections
To clear an individual selection:
1 Hold down CTRL when you click the item.
To clear all selections:
1 Click File, and then click Clear Selection.
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Types of Connections
Whether you’re in a hotel on the road, at home on a Saturday, or with your laptop anywhere, Laplink 
Gold lets you use any connection type you have to get access to everything you need. Laplink Gold 
supports connecting via a modem, a network, a network server, the Internet and more. You determine 
how to connect by considering your office setup and what you want to accomplish when you are 
connected, and Laplink Gold helps you to get it done. 

Connection overview
Laplink Gold supports multiple connection types. You can 
configure Laplink for the connections you use frequently, or 
select your connection when you start Laplink. All that is 
required is that a version of Laplink (7.5 or higher) runs on 
both the Guest and Host computers and that your computer 
is able to make a connection. 
Before you can use Laplink Gold to connect to another 
computer, you must determine how to make that connec-
tion using the resources available to the two computers.
Once you have setup your connection you can modify or 
create Address Book entries. See”Configuring the Address 
Book” on page 29 for more information.

About cable connections 
If both computers are in the same location, you can use 
Laplink’s USB 2.0 (included in boxed purchases) to link the 
two computers. Laplink will connect automatically, unless 
configured otherwise. See ”Local security” on page 24.

About Laplink Internet connections

Now you can use Laplink Internet to easily and securely 
connect to other Laplink Gold 12 computers over the 
Internet. Laplink Internet is accessible to Laplink Gold 12 
users who sign up for Laplink Internet accounts and 
associate their computers to those accounts. This type of 

connection gives you the full range of Laplink Gold features 
from any Internet connection. The Host computer must 
allow Laplink Internet connections and be registered with 
the service.

About LAN (Network) connections

If your office has a network, you can connect to the network 
via a VPN or other methods, and then to any computer 
running Laplink Gold on the network. Using the Remote 
Control service, you can access any network resources 
normally available to you from the office.

About modem connections
If your connecting (Guest) computer is equipped with a 
modem, then you can connect to the office computer 
directly. The Host must allow incoming modem connec-
tions. See ”Modem Callback” on page 22. 
Leave Laplink Gold running when you leave the office, and 
ensure that it can be connected to by modem. Then con-
nect as a Guest to run programs and transfer files as you 
would normally.

About Dial-Up Networking connections 
Use Dial-Up Networking to access a network remotely. By 
dialing in to a dial-up server (RAS) on the network, you can 
connect to any computer running Laplink on that network.
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About other connections
Laplink Gold also supports the following types of connec-
tions:
CAPI/ISDN
If you have CAPI/ISDN configured on your machine, you 
can make a connection.
Internet Locator Service
If the Host computer has a published ILS address, you can 
use this to connect. However, Laplink Internet is the pre-

ferred way of using the Internet to make Laplink connec-
tions.
Wireless (Infrared)
Wireless (Infrared) connections are only supported for Win-
dows 98 SE and Windows Me. If both computers are run-
ning Laplink, you can use this connection, unless the Host 
computer is configured to enforce Local security. See ”Local 
security” on page 24.
Wireless connections via your mobile phone, Aircard or 
other wireless device are treated like ‘wired’ connections.
78



Laplink Gold 12
Determine your connection type
Now that you have read about the different connection 
types available, you can determine which ones you will 
want to use. 

Table 1: Connecting over the Internet

Can you connect to the Internet on 
your Guest computer?

Then connect to a Laplink Gold Host computer over the Internet this 
way:

For details 
see

No, but the office has VPN server. Establish a VPN connection to the office, then use Connect Over LAN 
(Network) to supply the IP Address of the Host computer. page 85

Yes
If either computer is located behind a firewall, consider using Connect over 
Laplink Internet  for simple, secure connections without the hassle of con-
figuring a firewall. 

page 84

No, but the office has a direct connec-
tion to the Internet.

Use Connect Over Dial-Up Networking to dial in to a network server and 
connect over the office Internet connection. page 91
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Table 2: Connecting over cable, networks or modems

What resources are
available for connections Then connect to another Laplink computer this way: For details 

seeon the Host 
computer?

on the Guest 
computer?

USB, parallel or 
serial port

USB, parallel or 
serial port

Attach a Laplink USB, parallel, or serial cable to each computer. The connection 
opens automatically. To connect manually, choose Connect Over Cable.
Serial connections are available in all versions of Windows. 
Parallel connections are available in Windows 98 and Windows ME.
USB connections are available in Windows 98, ME,2000, XP and 2003.

page 81

TCP/IP or IPX 
network

TCP/IP or IPX 
network

Use Connect over LAN (Network).
Network connections are available in all versions of Windows.

page 85

modem modem
Use Connect over Modem and dial in to the modem on the Host computer.
Modem connections are available in all versions of Windows.

page 89

modem modem and net-
work

Use Connect over Modem to connect directly to the Host computer and access 
all of the network resources available to that computer. page 89

modem network with a 
dial-up server

Use Connect over Dial-Up Networking to dial in to the dial-up server and con-
nect to any Laplink Gold Host computer on the network. page 91

network network Use Connect over LAN (Network). page 85
80



Laplink Gold 12

Connecting by Cable
To connect two computers by Laplink cable, attach a serial, parallel, or Universal Serial Bus (USB) to 
the computers and start Laplink on both computers. No separate USB cable driver installation is required. 
Autoconnect, the default setting for cable connections, opens a connection automatically. To manually 
connect select Cable (USB, Parallel, Serial) from Connect Over on the Shortcut bar. 

Attach one end of 
the yellow Laplink 
parallel cable to a 
parallel port on 
each computer. 
Only available for 
Windows 98/ME

The blue Laplink serial cable 
has two connectors at one 
end, but only one connector is 
attached at a time: Use the 
larger connector if one of the 
computers has an older 25-pin 
serial port. Otherwise, attach 
one of the smaller connectors 
to each computer.

Attach one end of 
the Laplink USB 
cable to a USB port 
on each computer.

NOTE - USB-to-serial 
adapter or gender-
changing devices of 
any kind are not sup-
ported for use with 
Laplink Gold.

USB Network and parallel cable con-
nections are the fastest. USB cables 
can transfer data up to 500 times faster 
than serial cables. 
In addition, you can attach a USB cable 
to any USB peripheral that incorporates 
a “hub” to which other devices can be 
connected. This feature lets you use 
more than one USB-compatible device 
at a time.
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Choose the type of cable (serial, parallel, or USB) you are 
going to use based on the cables and ports you have avail-
able. A retail Laplink USB 2.0 cable is included in the 
Laplink Gold package. To purchase more cables in bulk 
with volume discount, visit http://www.laplink.com or call 
Laplink sales.
Ports are the connectors to which you attach cables and 
peripherals like printers and external modems. To find out 
which types of ports are available, consult the documenta-
tion or the Windows Device Manager for your computer.
Once you decide which kind of cable connection you’ll use, 
plug a Laplink cable into both computers. 

Before you connect by cable
• Attach a Laplink USB cable to each computer.

NOTE When attaching the USB cables that come with 
Laplink Gold for the first time, Windows will detect the 
device and install the drivers automatically. Click Next 
and then Finish in the Found New Hardware wizard to 
complete driver installation and hardware setup. 

• Ensure that the proper port (serial, parallel, or USB) is 
enabled in Laplink on both computers. See ”Connecting 
by Cable” on page 81”

• Run Laplink on both computers.

Connecting the computers
When you start Laplink on two computers connected by 
cable, they automatically connect. Autoconnect is the 

default setting for cable connections. If you change this set-
ting, you can connect to the other computer manually. See 
”Connecting by Cable” on page 81” for more information.

TIP If the connection does not open automatically, 
click Options, and then Port setup. Verify that the 
appropriate port (COM, LPT, or USB) is enabled for 
cable.

Connecting by cable when multiple cable 
ports are enabled
If your computer has multiple cable ports enabled, Laplink 
Gold offers you the option of connecting through the cable 
connection type you choose. You will see the following 
screen only when connecting from the Address Book.

Laplink USB cable speeds are significantly faster than serial 
or parallel cables.
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Click services to run when 
connecting Laplink Internet 

Open connections

Now that you have activated your Laplink Internet account 
and associated the computers to that account, you may 
establish an connection with those computers. To connect,

1. Open Laplink Gold on both machines on your 
account. Laplink Gold 12 must be running on 
machines with which you will establish a connec-
tion.

2. On the Shortcut Bar, click Connect Over Laplink 
Internet.

3. This will bring up the Laplink Internet Logon dia-
log box. Enter your username and password and 
click OK.

4. The Connect Over Laplink Internet selection dia-
log box appears. Click the computer name that you 
wnat to connect to, and select the services that you 
want to use.

5. Click OK. The connection will be established with 
the services that you have selected.

To connect via Laplink Internet
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Connecting by Laplink Internet
If you can connect to the Internet, you can connect to other Laplink Gold 12 computers. Laplink Internet 
lets you reliably connect around firewalls, routers, and proxy servers using a Laplink Internet account. 
When you launch Laplink Gold 12 for the first time you are prompted to create a Laplink Internet account 
and configure your PC to use Laplink Internet. From the Laplink Internet Web page, you can sign up for, 
configure, and manage your account. The first year of Laplink Internet service is included at no additional 
cost.

About Laplink Internet
If you have Internet access you can use Laplink Internet to 
connect your computers. To use Laplink Internet you must: 
• Create a Laplink Internet account.
• Associate each of your computers with your Laplink 

Internet account. Laplink Internet is a service available 
to Laplink Gold 12 users. The first year of Laplink Inter-
net is included at no additional cost.

Creating a Laplink Internet account
To create a Laplink Internet account for the first computer to 
which you will want to connect, click the popup dialog that 
first appears when you start Laplink Gold 12. Then do the 
following:
1 Start Laplink Gold 12.
2 Click Yes in the popup dialog that appears asking if you 

want to register with Laplink Internet.
3 You will be presented with a Web page. Fill in all the 

required fields and click Submit.
You have created your Laplink Internet account. You will 
now need to associate computers that you want to connect 
to with this account.

To add additional computer(s) to 
which you will want to connect
1 Start Laplink Gold 12 on the computer you want to add.
2 Click Yes in the popup dialog box that automatically 

appears asking you if you want to register with Laplink Inter-
net.

3 A registration Webpage appears. Click the hyperlink, Click 
here to assign this PC to that account.

4 Enter your username and password and a descriptive 
name for this PC. (This is the name that will appear in the 
Connect Over Laplink Internet dialog box).

5 Click Submit.
You have assigned the computer to your account and can 
connect to and receive connections from computers associ-
ated with your Laplink Internet account. 
Laplink Internet resolves Internet connections automatically. 
Only Laplink Gold 12 allows you to securely connect your 
computer to any other computer without needing to config-
ure firewalls or routers. You will be able to log in and access 
any of your other computers provided that they have valid 
Internet accounts, are online and available for connections, 
and are running Laplink Gold 12.
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Connecting by LAN (Network)
To connect to any computer running Laplink Gold on your Local Area Network, select LAN (Network) 
from the Shortcut bar, then pick the network computer you want to connect to or supply its TCP/IP 
address or name.

Use Connect over LAN (Network) to link computers 
on a home or office network.
You can click the name of a computer or switch to 
the TCP/IP Addresses tab and enter the com-
puter’s IP address or name.

If you have a large list of computers to choose from, 
Computer Name Filter allows you to limit the list 
by entering a full or partial name for the Host com-
puter you are looking to connect, then clicking 
Refresh List.
Select the Services you want to open with your 
connection. File Transfer is the default service. 

Clicking the Refresh List button updates the list of 
computers available since you first opened the win-
dow.

Clicking the Address Book button, opens the 
Address Book. From the Address Book, select the 
connection you want to open
Clicking the Port Setup button, opens the Port 
Setup options window.

NOTE Choose Services before 
connecting. Once you connect, 
you cannot select more Services 
to run.
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You can establish a Laplink connection to another computer 
on your home or office network, whether it is an IPX (Novell 
NetWare) network or a TCP/IP network.
You can usually open a network connection by clicking the 
computer’s name in a list of Laplink computers on the net-
work. To open a connection to a computer that lies outside 
your portion (subnet) on a TCP/IP network, however, you 
must provide the computer’s TCP/IP address or name. 

Before you use Connect over LAN 
(Network)
• The security setup of the Host computer must be con-

figured to allow incoming connections. See ”Allowing 
incoming connections” on page 16.

• The network ports (either TCP/IP or IPX) must be 
enabled in Laplink on both computers. See ”Connecting 
by LAN (Network)” on page 85. If you aren’t sure which 
protocol is being used on your LAN, contact your net-
work administrator.

• Laplink must be running on both computers.
NOTE Not only does Connect over LAN (Network) 
work over local networks, but it also connects over the 
Internet. For details see ”Connecting by LAN (Network)” 
on page 85

Manually connecting 
If the computer you want to connect to does not appear on 
the connections list of available computers, you may be 

able to connect to it manually. You will need to know the 
TCP/IP address of the Host computer in order to connect.
To find out a computer’s TCP/IP address in Windows 
98, or Windows ME:
1 On the Options menu, click Port Setup.
2 Click TCP/IP Network in the Ports list, and then click Con-

figure.
3 The TCP/IP address appears in the IP Address box.
To find out a computer’s TCP/IP address in Windows 
2000, XP or 2003:
1 Click the Windows Start button, click Programs, and 

then Accessories. Click Command Prompt.
2 Type IPCONFIG and press ENTER.

The TCP/IP address for that computer appears in the IP 
Address line.

Filtering the list of available network 
computers
You can display the name of a particular computer in the 
Connect Over LAN (Network) dialog box by typing all or 
part of the name in the Computer Name Filter box. Click 
Refresh List. This filter is saved.The next time you connect 
over LAN (Network) it will be used. 
To display the names of all available computers again, click 
the arrow next to the Computer Name Filter box, click All 
Computers, and then click Refresh List.
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Connecting to previous Laplink versions behind firewalls
Although Laplink Internet is the easiest way to connect to 
Laplink Gold 12 computers, you may need to connect to 
older versions of Laplink that are running behind a firewall. 
You can use Laplink Gold’s Firewall Connection Service to 

make the connection. A detailed tutorial on configuring fire-
wall connections is available at http://www.laplink.com/sup-
port. From the main menu, click Tutorials. 

You must configure both computers before you can make a 
firewall connection. First, configure the Host computer 
(inside the firewall) to accept incoming connections using 
either a Log-in List or configuring a Public System (Log-in 
List is more secure) and then create an Address Book entry.

You must also create a Log-in list entry on the Guest com-
puter outside the firewall. This entry must match the 
Address Book entry you created on the computer inside the 
firewall.

When the Guest computer (outside the firewall) 
requests a connection, the Host computer (inside the 
firewall) uses the Address Book entry to initiate the con-
nection.

The Log-in name and password in the Log-in List 
entry must match the log-in name and password in 
the Address Book entry.
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NOTE A detailed tutorial is available by clicking on the 
Help menu, and choosing “Tutorials on the Web.”

Before you connect to a computer 
behind a firewall:
• Both computers must have an active connection.
• Only one of the two computers can be behind a firewall. 

It is not possible to connect if both computers are 
behind a firewall (note that the Laplink Internet feature 

can connect even if both computers are behind fire-
walls).

• The computer inside the firewall must publish its Inter-
net address through the Laplink Internet Directory 
server.

• The computer inside the firewall must have an Address 
Book entry that includes a unique computer name, user 
name, and password for the computer outside the fire-
wall to use.

• The computer outside the firewall must be configured to 
allow incoming connections.

• Laplink must be running on both computers.
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Connecting by Modem
Using modems and a phone line, you can connect to another computer or to an office network. For a 
direct, Laplink to Laplink connection, dial to a modem on another computer using Connect over Modem. 

Use Connect over Modem to dial a modem on 
the Host computer and open a Laplink connec-
tion.
Entries you have created for modem connections 
in the Address Book appear in the Connect over 
Modem Window. Select one of these options or 
enter a new phone number to dial.

For Best Results: Use only hardware-based 
modems, such as external (serial) modems. 
Most internal (software) modems are unreliable 
for Laplink connections. For the latest informa-
tion, visit www.laplink.com/support.

Connect over Modem window

NOTE Choose Services before 
connecting. Once you connect, 
you cannot select more Services 
to run.
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Before connecting over a modem
• The Laplink security setup of the Host computer must 

be changed to allow incoming connections. See ”Allow-
ing incoming connections” on page 16

• Laplink must be running on both computers.
• Modem ports must be enabled in Laplink on both com-

puters.

Using modem connections
You can dial a modem connection three ways:
• Create an Address Book entry, and dial directly from 

the Address Book.

TIP If you added the connection to your favorites, you 
can connect from the Shortcut Bar.

• In the Shortcut Bar Connect Over panel, click Modem 
and choose an entry from the list

• Select Connect Over, and then Modem and manually 
enter the number you want to dial. 
NOTE Laplink dials the number exactly as you type it, 
regardless of how you have set up Dialing Properties in 
other address book entries.
90



Laplink Gold 12

Connecting by Dial-Up Networking
Use Dial-Up Networking to connect to a dial-up server (RAS) and log on to a network from outside the 
office. Then connect to other Laplink computers on the network and use network resources as if you were 
still in the office.

Use Dial-Up Networking to connect to a dial-up 
server on your network. Then open connections 
to other Laplink computers on the network.

Connect over Dial-Up Networking window

Your existing Dial-Up Networking connections 
are displayed when you select Connect Over > 
Dial-Up Networking.
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Before you use Dial-Up Networking
Use Dial-Up Networking to access a network remotely. By 
dialing in to a dial-up server (RAS) on the network, you can 
connect to any computer running Laplink on that network.
You can also connect to Laplink computers on the Internet 
and browse the Internet using the Internet connection in the 
office. In short, you can access the same network resources 
you use in the office.
• Dial-Up Networking, a Windows feature, must be 

installed on the Guest computer. See Windows help for 
instructions.

• Your network must have a dedicated dial-up server 
(such as Novell NetWare Connect, Windows Remote 
Access Server, or Shiva NetModem). The computer 
you connect to must be connected to an IPX or TCP/IP 
network. 

• The Laplink Gold security setup on the Host computer 
must be configured to allow incoming connections. For 

more information, See ”Allowing incoming connections” on 
page 16.

• Laplink must be running on both computers.
• TCP/IP or IPX ports must be enabled.

Using Dial-Up Networking 
connections
For step-by-step instructions on how to create and use a 
Dial-Up Networking connection, see the on-line Help sys-
tem.
You can use a Dial-Up Networking connection two ways:
• Select Connect Over, and then Dial-Up Networking 

and choose an entry from the list
• Select Connect Over, and then Dial-Up Networking 

and manually enter the number you want to dial. 
NOTE Laplink dials the number exactly as you type it, 
regardless of how you have set up Dialing Properties in 
other address book entries.
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Other Connection Types
Laplink Gold 12 supports a number of alternate ways to connect. It supports wireless (infrared) CAPI, 
ISDN, and Internet Locator Services (ILS). Requirements for using these types of connections vary.

Connecting over wireless (infrared)
If you are running Laplink Gold 12 on a Windows 98 or Win-
dows ME computer, you can connect to a Host using infra-
red. When you start Laplink, the Guest computer 
automatically detects the Host and opens a connection.
Using Laplink, you can open short-range connections 
between computers equipped with infrared (IrDA) ports. 
Wireless connections are only supported in Windows 98 and ME.

NOTE Other wireless devices, such as mobile phones, 
Aircards and other wireless modems, are treated just 
like a other ‘wired’ modems, and can be used with Dial-
Up Networking over a LAN or with any other connection 
method.

See your Windows documentation for instructions on how 
to setup infrared connections.

TIP When you install the infrared driver, specify any 
COM port from COM1 to COM9 as the redirected port. 
In Laplink, click Port setup (Options menu) and enable 
the same redirected port for wireless communications.

Before connecting by wireless 
(infrared)
• Make sure both Guest and Host computers are within 

range of each other. 
• Ensure that the wireless port on each computer is 

enabled in Laplink. 
• Run Laplink on both computers.

Connecting by wireless (infrared)
For step-by-step instructions on using wireless (infrared) 
connections refer to the on-line Help system.
When you start Laplink on both computers, a connection 
opens automatically over their wireless devices. Autocon-
nect, the default setting for wireless connections, forces the 
computers to connect to each other. See ”Allowing incoming 
connections” on page 16”. If you change this setting, you can 
connect to the other computer manually.

TIP If the connection does not open automatically, 
click Options, and then Port setup and verify that the 
appropriate port is enabled.
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Connecting over CAPI 2.0/ISDN
If CAPI 2.0/ISDN lines are available on the Guest and Host 
computers, and if both computers are set up for CAPI 2.0/
ISDN communications, you can open a high-speed connec-
tion to use Laplink services. CAPI/ISDN options are only 

available if CAPI/ISDN is already configured for use on your 
computer. To connect, click the Connect pulldown menu 
and select CAPI 2.0/ISDN.

Use Connect over CAPI 2.0/
ISDN to link computers wher-
ever the CAPI 2.0 version of 
ISDN is available.

NOTE Both modems 
must be ISDN modems. 
Digital modems cannot 
communicate directly 
with analog modems. 

NOTE Choose Services before 
connecting. Once you connect, 
you cannot select more Services 
to run.
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Before using CAPI 2.0/ISDN
• A CAPI 2.0/ISDN adapter and driver must be installed 

on both computers.
• Both computers must be running a version of Laplink 

that supports CAPI 2.0/ISDN.
• The security setup of the Host computer (the one you 

are connecting to) must be configured to allow incom-
ing connections. See ”Allowing incoming connections” on 
page 16”.

• CAPI 2.0/ISDN ports must be enabled in Laplink on 
both computers.

• Laplink must be running on both computers.

Connecting over CAPI 2.0/ISDN
For step procedures to use CAPI/ISDN connections, refer 
to the online help system.
CAPI 2.0/ISDN is an implementation of ISDN, an interna-
tional communications standard for sending voice, video, 
and data over digital telephone lines, at faster rates than 
those possible using modems.
CAPI 2.0/ISDN is widely used in Europe, particularly in Ger-
many. In North America, ISDN seldom is implemented as 
CAPI 2.0, but you can still use your ISDN device for high-
speed Laplink connections. If you use your ISDN device as 
a modem, use Connect over Modem in Laplink. If you use it 
to dial in and logon to a network, click Connect Over LAN 
(Network) in Laplink.

Changing CAPI 2.0/ISDN 
performance in Laplink
Before using CAPI 2.0/ISDN in Laplink, you may want to 
customize the way that Laplink responds to CAPI 2.0/ISDN 
calls and uses the two channels available for Laplink com-
munications. For example, you can specify that Laplink not 
respond to any incoming calls to a particular channel, or you 
can double the rate at which data is transmitted over your 
CAPI 2.0/ISDN connections. 
To change CAPI 2.0/ISDN performance in Laplink,
1 Enable a connection.
2 Click Options, then Port Setup.
3 Under Port Settings, click CAPI.
4 Click Configure. If you do not want Laplink to answer any 

incoming CAPI 2.0/ISDN calls, clear Enable box under 
Auto Answer.

5 To answer calls to only one number, type the number in 
Accept Calls Only on the Following Numbers.

6 If you want to combine the two CAPI 2.0/ISDN channels for 
faster connections, check Enable under Channel Bond-
ing. Be sure that channel bonding is also enabled on the 
computer you will connect with.

7 Customize the Timeout options as necessary.The Call-
back Timeout, Callback Delay, and Redial Delay settings 
are specified in seconds.
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.

Answering calls
By default, Laplink is set up to answer all incoming CAPI 
2.0/ISDN calls on both channels. You can modify this so 
that it does not answer any of these calls or it answers calls 
to just one of the channels.

NOTE If you don’t want Laplink to answer any incoming 
calls, clear the Enable box under Auto Answer. 

Ensure that the Accept Calls Only on the Following 
Numbers box is blank.
TIP When typing the number to accept calls to, use 
only numerals; avoid characters like dashes, parenthe-
ses, slants, and periods. When typing more than one 
number, use a semicolon to separate them.

In Port setup, you can 
modify the way Laplink 
implements CAPI 2.0/
ISDN connections.
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Channel bonding
CAPI 2.0/ISDN provides two channels that can be used for 
Laplink communications. Each channel has a transmission 
speed of 64 Kbps. By combining (“bonding”) these chan-
nels, the transmission rate can double to 128 Kbps.
By default, Laplink does not use channel bonding, even 
when both channels are available. This setting keeps trans-
mission costs to a minimum for users who pay additional 
fees for each channel connection.

For faster transmissions, enable channel bonding. When 
both channels are available, Laplink can then transmit at 
speeds up to 128 Kbps. 

NOTE Be sure to enable channel bonding on both 
computers. Laplink may not be able to make a connec-
tion between them otherwise.

When one channel is already in use, Laplink uses the avail-
able channel to transmit at 64 Kbps, even when channel 
bonding is enabled.
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Connecting via Internet Locator Service
.

Internet Locator Service configuration window

You can use your own 
ILS directory server or the 
Laplink ILS server.

If you need to connect over the Internet, you will find Laplink Internet to be a fast, easy, and secure 
method. However, if you are upgrading a prior version of Laplink Gold and you choose to continue using 
Laplink’s Internet Locator service, please refer to the following. 

NOTE Choose 
Services before 
connecting. 
Once you con-
nect, you cannot 
select more Ser-
vices to run.
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Before you connect over ILS
• Make sure Laplink is configured to publish your ILS 

address. 
NOTE ILS connections are configured by clicking 
Options, and then Internet Directory Options.

• Know the Internet address of the Host computer.
• Run Laplink on both computers.

Connecting by ILS
For step procedures on using ILS connections, refer to the 
online help system.
You can manually enter an ILS address to connect to, or if 
you have one configured in the Address Book, select it from 
the list of available connections.

TIP Laplink Internet also allows you to connect over 
the Internet and does not require firewall configuration.
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Description of the Connect Options Dialog Box
Laplink Gold 12 offers instant connectivity so that you can perform any function on a remote computer as if 
you were sitting at that computer. Connect Options configures all connection settings and alerts. It is 
important to configure Connect Options before making a connection because configuration cannot be 
changed once a connection is made.

The Laplink Gold 12 Connect Options control dialog helps you select services and set alerts easily and 
quickly. You can even choose to have a connection start automatically or prompt you to connect when 
you start Laplink Gold 12. Check boxes make it simple to enable or disable services used during remote 
sessions.

Clicking the Restored saved connec-
tions at startup dialog allows you to 
save a connection, then have that con-
nection start automatically, or prompt you 
before connecting, when you start Laplink 
Gold 12.

Checking these buttons turns the 
Restore Connection prompt dialog 
(Ask Before Connecting) on and off.

TIP Create a folder to save the connec-
tion file(s) that you want to have restored 
at startup. Before closing Laplink Gold 
12, make sure that you have the correct 
connection file selected.
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In the Connect Options dialog box, click Enable 
Autoconnect if you want to enable functions during 
a remote session. The default setting for Connect 
Options is File Transfer. Other services will not run 
during a remote session unless you check them 
first.
In certain cases, you may not want some services 
to be active during a remote session. Below is a 
brief summary of services and their functions:

• File Transfer
Enables the Host and Guest to exchange and 
synchronize files

• Print Redirection
Enables printing services for Host and Guest to 
print on either a remote or local printer.

• Text Chat
Enables Host-Guest text chat communications.

• Voice Chat
Enables Host-Guest voice chat communications,

• Remote Control
Enables traditional Laplink Rremote Control.

• Remote Desktop
Enables Laplink Remote Desktop to use the 
Microsoft Remote Desktop feature in Microsoft 
Windows XP Professional and Server 2000 and 
Server 2003 running Terminal Services.

Clicking the checkbox for Connection Alerts notifies 
you when another computer connects to yours to use 
the services that you select in Enable Autoconnect. 

Choosing Connect Options

Enabling Disconnect options
You can determine whether you want an inac-
tive connection to be automatically closed. Click 
Disconnect Inactive Connections, and then 
type the desired number in the field. 
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Configuring and Saving Connections
Once you have established a connection, you can save it for easy restoration later. You can restore a 
saved connection by double clicking a shortcut icon, setting up Laplink to restore the connection 
automatically when you start Laplink, or restoring the connection while running Laplink. When Laplink 
restores a connection, it connects to the same computer or computers and opens the same services. 

Configuring connections determines how you want you con-
nections to be handled—automatically or manually. Instead 
of spending time connecting to the same computer and 
opening the same services time after time, you can save the 
connection and use the saved connection as a convenient 
way to reconnect later. 

TIP Saving a connection is not the same as creating 
an address book entry, but another way to access your 
frequently used connections.

NOTE When you save a connection, you record such 
details as the number and types of connections 
(modem, network, Internet, cable), the names of com-
puters, the user name and password if necessary, and 
the kinds of services in use. Each connection is saved 
in My Documents as a .LLC file. Opening the file 
reopens the connections and services and arranges 
windows to appear as before.

You can restore a saved connection three ways:

• Double-click its desktop icon.
• Set Laplink to restore the Connection at 

startup, whenever you run Laplink.
• Restore the connection yourself while 

using Laplink.
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Handling Saved Connections
Connect Options determine how you want your saved 
connections handled - automatically or manually. You can 
also configure how cable and infrared connections are man-
aged.
You can access these options from the main menu. Click 
Options, and then Connect Options. For step procedures 
on Connect options, view the online help system

Saving a connection
Once you open a connection, select Connect, and then 
Save Connections... from the main menu.
Saved connections are not the same as Address Book 
entries.

NOTE By default connections are saved in the My 
Documents folder. For ease of use, do not change this 

location as by default, Laplink opens My Documents to 
look for connections.

Restoring a saved connection
Once you have saved a connection, you can restore it three 
ways:
• If you created a shortcut icon on your Windows desk-

top, double-click the icon.
• Set up Laplink to restore the connection when you run 

Laplink again.
• Open the connection file while running Laplink. From 

the main menu, click Connect, and then Restore Con-
nection.
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How to Connect
For your convenience, Laplink offers a variety of ways to connect. You can connect from the Address 
Book (see ””Configuring the Address Book” on page 29, or open a saved connection from its shortcut on 
your desktop (see ”Configuring and Saving Connections” on page 102), or access connection options from 
the menu bars. Once you have your connections set up and configured, then you’re ready to connect!

Connect from the Shortcut BarConnect from the Main Menu

You can open 
the Address 
Book from the 
Shortcut Bar.
Your first ten 
entries in your 
Favorites are dis-
played under the 
Address Book.
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Laplink Remote Desktop & Laplink Remote Control 
Laplink Remote Desktop and Laplink Remote Control are two similar but different ways of using Laplink 
to take over and control a Host computer from a Guest location. Both features have strengths that make 
them the best choice for specific situations. 

About Laplink Remote Desktop
Laplink Remote Desktop feature lets you utilize the WIn-
dows Remote Desktop feature built into Windows XP Pro-
fessional, Windows Server 2000, and Windows Server 
2003 running Terminal Services. 
While Windows 98 SE and Windows 2000 computers run-
ning Laplink Gold 12 can connect to and establish Remote 
Desktop sessions with XP Professional and Windows 
Server 2000/2003 computers running Terminal Services, 
the reverse is not true. Windows Remote Desktop is not a 
feature available in Windows 98, Me or XP Home so 
Remote Desktop sessions cannot be established.
In the event that Laplink Gold 12 detects that the Laplink 
Remote Desktop session cannot be established, it will auto-
matically establish a Laplink Remote Control session.

About Laplink Remote Control
The Laplink Remote Control feature uses Laplink’s Remote 
Control software, which is installed with Laplink Gold. 
Laplink’s Remote Control software can run on any Laplink-
compatible machine. Remote Control sessions can be 
established between any two Laplink-equipped computers. 
With Laplink Remote Control, two Laplink-equipped com-
puters agree that one of them will connect to the other and 
control its resources. 

Terminology
When you open a remote control window with either Laplink 
Remote Desktop or with Laplink Remote Control on your 
computer, the computer initiating the session becomes the 
Guest computer and the computer allowing the connection 
and being control becomes the Host computer.
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About Laplink Remote Desktop
The Laplink Remote Desktop feature in Laplink Gold 12 enables you to utilize the Remote Desktop 
feature built into Windows XP Professional and the Windows Terminal Services feature in Windows 
Server 2000 and Windows Server 2003. This new feature provides an alternative to Laplink Remote 
Control already well known to past Laplink users. 

Windows Remote Desktop on its own allows you to control 
another machine on your network. However, if either of 
those computers is behind different firewalls, or not on the 
same network, or needs to be accessed via the Internet, 
Windows Remote Desktop cannot be used. When you use 
Laplink Gold 12 to access Windows Remote Desktop fea-
tures, you get the best of both worlds. You get Laplink’s con-
nection management and the user experience you are used 

to, and the ability to securely connect through firewalls using 
Laplink Internet.

Requirements
Before you use Laplink Remote Desktop, you’ll need to 
meet the following requirements on the Guest and Host 
computers
.

What software is
available Can I use Laplink Remote 

Desktop Feature?on the Guest computer? on the Host computer?

Laplink Gold 12

Windows Remote Desktop 
and Laplink Gold 12 Yes

Terminal Services Client 
and Laplink Gold 12 No

Terminal Services Server 
and Laplink Gold 12 Yes
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Enabling Windows Remote Desktop
In order to use Laplink’s Remote Desktop connection, Windows XP Remote Desktop must be enabled. To use Laplink Remote 
Desktop,

1. Click Start, and then Control Panel. Click the System icon.
2. If you can’t see the System icon, click the Switch to Classic View link in the Control Panel Shortcuts menu.
3. Click the Remote tab and select the Allow users to connect remotely to this computer check box. 
4. Ensure that you are either an administrator or a member of the Remote Desktop Users group on your computer. 
5. Click OK. For more information on using Windows XP Remote Desktop, consult your Windows XP online help system.
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About Laplink Remote Control

When you open a Laplink Remote Control window, you can view and operate the Host as if you were 
sitting in front of it. Images from the Host appear on your screen in a Laplink Remote Control window 
within the Laplink workspace. In a Laplink Remote Control session, you are a Guest on the Host 
computer.

Laplink Remote Control provides a way to operate another 
computer at a distance. You begin Laplink Remote Control 
as soon as you open a Laplink Remote Control window. 
While you are working in this window, your mouse moves 
the mouse pointer on the Host computer, your keyboard 
types characters on the Host computer, and your Laplink 
Remote Control window shows the Host computer’s 
screen.

Requirements
The Host computer must allow you to run a Laplink Remote 
Control session. See, See “Configuring Security” on page 16.
To optimize performance on your computers see, See “Cus-
tomizing Laplink Remote Control Performance” on page 125. 

Before you use Remote Control 
Because Laplink supports multiple connections, you can 
open Laplink Remote Control sessions on multiple Hosts. 
Prior to initiating a Laplink Remote Control session, make 
sure the Host you are going to connect to:

• allows you to initiate a Connection
• grants you permission to use Laplink Remote Con-

trol.
For more information see, See “Allowing incoming connec-
tions” on page 16.
The Host screen appears on your screen as a window 
within Laplink. The name of the Host computer appears in 
the window’s title bar. You can move, resize, minimize, or 
maximize the window as you would any other window. Use 
the scroll bars to view other parts of the Host screen.
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Hosting a Laplink Remote Control Session
For Remote Control to take place the Host needs to be running Laplink—you do not need to be at the 
computer. Sensitive information is protected by the conditions of the connection. You can grant greater 
access, or limit these conditions, through the Laplink security system. See “Configuring Security” on 
page 16.for further information.

When you configure your computer to accept incoming con-
nections you specify who can connect to the computer and 
the kinds of services they can use. For example, you can 
limit a Guest to Laplink Laplink Remote Control only, or you 
can allow access to Text Chat and File Transfer as well. 
You can even allow a Guest to blank your computer’s 
screen or disable the mouse and keyboard. All of these 
options are set in the Laplink security system.
You can leave the Host computer unattended, giving an 
authorized user exclusive control, or you can stay at the 
computer and interact with the Guest by trading off control. 
For example, the two of you could edit a document together, 
participate in a training session, or explore a new program.
When in a Laplink Remote Control session, both users can 
end up competing to control the mouse and keyboard, 
which can be frustrating and confusing for both parties. To 
avoid this problem, consider using Host Locking On Con-
nect to disable the Host machine’s keyboard and mouse, 
and if you choose, to blank the Host machine’s screen. See 
See “Disabling the Host keyboard and mouse and blanking its 
screen” on page 115.” for more information.

TIP A Host can be controlled by only one Guest com-
puter at a time. However, other computers can connect 
using any other services.

What you see on a Host
When a Guest connects and begins Remote Control, your 
Laplink workspace is minimized on the Host. If you double-

click the icon, the Laplink workspace is restored to a win-
dow.
At the bottom of the restored Laplink workspace, you see an 
icon for the Laplink Remote Control connection. The icon is 
identified by the name of the Guest computer. Clicking this 
icon displays a Windows menu with standard commands. 
Clicking Close closes the Remote Control connection.

TIP You can make the Laplink workspace remain a 
window when a Guest connects: Click Remote Control 
Options on the Options menu, and then click the Host 
tab. Clear this box: Minimize Laplink When This Com-
puter Is a Host.

Reversing a Remote Control session
There may be times when the Guest and you want to switch 
roles so that you become the Guest controlling the remote 
computer.
To reverse the direction of Laplink Remote Control, the cur-
rent Laplink Remote Control connection must be broken on 
either computer. Then, as the prospective Guest, you open 
a Laplink Remote Control window and begin controlling the 
other computer.
To avoid breaking the network connection when a Laplink 
Remote Control connection is closed, make sure that there 
is at least one other service window open, such as File 
Transfer. If Laplink Remote Control is the only service in 
use, open another service window before closing Laplink 
Remote Control.
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Controlling a Laplink Remote Control Session
As the Guest, you control the Laplink Remote Control session. You can determine if the Host has 
access to its computer while you are in control. You can modify how the Host screen is displayed. You 
have a shared clipboard between the computers, can take screenshots on the Host and save them to the 
Guest, and share system information. This section walks you through all options and functions you have 
for controlling a Host. 

Viewing the Host
As a Guest, you can alternate between two views of the 
Host screen. Your first view appears in a window within 
Laplink. Inside the window, you control the Host; outside the 
window, you perform other tasks, in Laplink or in other appli-
cations on your computer. Switch to a full-screen view when 

you want to maximize your view of the Host and use Laplink 
Remote Control exclusively. When you cannot see the 
entire Host screen even in full screen, you can change the 
resolution of the Host screen or scale its image to fit within 
your view.

To alternate between a window and a full-screen view of 
the Host, press CTRL+SHIFT+F.
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Devoting your entire screen to a view 
of the Host
You can view the Host screen in two ways:
• In a window within Laplink (the default)
• As a full-screen display, hiding Laplink and the rest of 

your Windows workspace
In a window view, you have quick access to File Transfer, 
Text Chat, and other Laplink features. You can also switch 
to other applications on your computer.
To maximize the area in which you view and control the 
Host, switch to a full-screen view. Your entire screen is now 
devoted to controlling the Host; you do not have access to 
your own applications. When you want to do something 
other than control the Host, switch back to the window view.
To switch between window and full-screen view:
• Press CTRL+SHIFT+F.

TIP In full screen, you can also switch to a window 
from the copy of Laplink running on the Host: If Laplink 
is an icon, click it to restore it to a window. Then click 
the icon representing your Laplink Remote Control win-
dow, and click Guest Full Screen to clear the check 
mark.
TIP To make Laplink Remote Control alternate 
between full screen and window bypassing the window 
view, click Options, and then Remote Control 
Options. On the Guest tab, check the Always Use 
Full-Screen box.

Viewing the entire Host screen at 
once
There are two ways to fit the Host screen into your view. For 
step procedures, see the online help system.
• From your computer, lower the resolution of a higher-

resolution Host screen to match that of your screen.
• Scale the image of the Host screen to fit within your 

view by pressing CTRL+SHIFT+S.
Temporarily changing the resolution of the Host 
display adapter  When using a laptop to control a desk-
top, you often can’t view the entire Host screen at once if the 
desktop operates at a higher screen resolution. From your 
laptop, you can lower the desktop’s screen resolution to 
match your laptop’s.

NOTE You cannot lower the resolution of a Host com-
puter unless its monitor and display adapter allow the 
change without restarting Windows. The Host must 
also be running a version of Laplink that supports this 
feature.

You can then view all of the Host screen in full-screen view. 
The original resolution is restored automatically on discon-
nect or at your direction.
Scaling the image of the Host screen to fit  You can 
also view the entire Host screen at once by scaling the 
image to fit within the Laplink window. You always see all of 
the Host’s screen, whether you are working in full screen or 
window, though the image may be distorted or compressed.
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Customizing keyboard control
By default, Windows system keys pressed on the Guest 
computer take effect on the Host. If you want the system 
keys to operate on the Guest while working in a Laplink 
Remote Control window, select Options > Remote Con-

trol Options > Guest tab > Execute on Guest. Through 
Remote Control Options, you can also change the key com-
binations that control your view of the Host.

TIP When you are working in a 
Remote Control window click 
CTRL+TAB and other Win-
dows system keys you press 
on your computer (the Guest) 
take effect on the Host.

To have system keys take effect on 
your computer instead of the Host 
computer, click Execute on Guest.
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Windows system keys
Windows system keys are key combinations that perform a 
variety of tasks. Pressing ALT+TAB, for example, switches 
to the program you used last. The Windows Start key found 
on most keyboards is another example. By default, Laplink 
sends most system keys to the Host during Laplink Remote 
Control: pressing ALT+TAB on the Guest therefore 
switches to the program last used on the Host.
You can make system keys work on your own computer 
when you are working in a Laplink Remote Control window.

TIP Windows system keys (except 
CTRL+ALT+DELETE) always take effect on the Host 
when you are using Laplink Remote Control in the full-
screen view.

TIP If you intend to control a Host computer using the 
keyboard exclusively (without a mouse), set the Win-
dows system keys to execute on your computer. When 
you want the keys to execute on the Host, switch to the 
full-screen view.

Laplink Remote Control shortcut keys
Laplink offers two shortcut keys to change your view of a 
Host screen. Pressing CTRL+SHIFT+F switches between 
full-screen and window view of the Host. Pressing 
CTRL+SHIFT+S switches between scaled-to-fit and normal 
view. (See page 111 for more information.)
You can change these default key combinations to certain 
other combinations. (To avoid interference with other 
Laplink and Windows shortcut keys, you are limited in your 
choice of replacements.)
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Disabling the Host keyboard and mouse and blanking its screen
From a Guest computer, you can ensure privacy and pre-
vent interruptions at the Host by disabling its keyboard and 
mouse and blanking its screen. To perform any of these 

“locking” operations from the Guest, click the appropriate 
command on the Session menu. On the Host, you must 
allow locking by changing the default security setup.

On the Host: Allow 
users to blank the 
screen and disable 
the keyboard and 
mouse when you 
grant them access 
through the Log-in 
List.

On the Guest: 
Blank the Host 
screen and disable 
its keyboard and 
mouse through the 
Session menu.
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Configuring a Host for locking
You can configure a Host to determine who can lock it and 
how it will be locked. Guests cannot lock the Host without 
your permission, and locking privileges you grant cannot be 
changed during a Laplink Remote Control session.
Whether you permit any kind of locking depends on how 
you intend to use Laplink. If you want to use Text Chat, for 
example, there should be no locking.
You grant locking permission by changing the security 
setup on the Host computer: On the Shortcut Bar, click 
Security, and then choose from the following two options:
• Set up a Log-in List by specifying Log-in List (Pro-

tected System) and adding one or more entries. In each 
entry, check any of the three boxes under Locking 
Permissions. The permissions apply only to Guests 
whom you provide with the appropriate log-in name and 
password. For more information about setting up a Log-
in List, see ”Allowing incoming connections” on page 16

• If security is not an issue, open the system to any 
Laplink user by clicking Anybody (Public System). 
Click Public Privileges, and then on the General tab, 

check Remote Control box, and then check any of the 
three boxes under Locking Permissions. The permis-
sions apply to all Guests.

Locking the Host from the Guest
With the permission of the Host computer, you can:
Blank the Host screen The Host’s screen is darkened, 
preventing your work from being viewed at the Host.
• Disable the Host mouse The Host’s mouse is 

locked, preventing anyone at the Host from using the 
mouse to interrupt your work.

• Disable the Host keyboard The Host’s keyboard is 
locked, preventing anyone at the Host from using the 
keyboard to interrupt your work.
TIP Through the Address Book, you can request the 
kinds of locking you want to take effect as soon as you 
open a Laplink Remote Control session. Your requests 
will be honored as long as they are allowed by the Host. 
For information on using the Address Book to make 
connections, see ”Configuring the Address Book” on page 
29
116



Laplink Gold 12
Rebooting and logging on to the Host
From a Guest computer, you can reboot a Host computer 
and restart Windows. To reboot a Host from the Guest dur-
ing Laplink Remote Control, click the Reboot Host com-

mand in the Session menu. To configure a Host for 
rebooting and restarting Windows, click Remote Control 
Options on the Options menu.

On the Host: Allow users to reboot 
the computer in Remote Control 
Options.

On the Guest: Reboot the Host 
from the Session menu.
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Rebooting the Host from the Guest
From a Guest computer you may want to restart a Host to 
put into effect changes you have made on that computer. 
Or you may want to restart a Host computer to ensure that 
no one else can call in after you disconnect.
To reboot the Host from the Guest during Laplink 
Remote Control:
• On the Session menu, click Reboot Host.

If Reboot Host is dimmed on the Session menu, the Host 
has not set the option to allow rebooting by a Guest.

Logging onto Windows 2000, XP or 
2003 from the Guest
You must always press CTRL+ALT+DELETE before you 
can log on to Windows.
To send CTRL+ALT+DELETE to the Host, do one of 
these:
• Press the key combination specified for this purpose on 

the Host. By default: CTRL+SHIFT+D.
• On the Host’s Session menu, click Send 

CTRL+ALT+DELETE to the Host.
• Click the Remote Control icon at the bottom of the 

Host’s Laplink workplace, and then click Feed 
CTRL+ALT+DELETE.

Configuring the Host for rebooting
You must configure a Host to allow any Guest to restart it 
during a Laplink Remote Control session. You can also 
require that the Host be restarted whenever a Laplink 
Remote Control connection is disconnected.

To configure a Host computer for rebooting:
• Click Options, then the Host tab in Remote Control 

Options, and check either or both of these boxes:
• Allow Guest to Reboot on Command Check this 

box to allow Guests to restart the Host using the 
Reboot Host command on their computers.

• Always Reboot When Guest 
Disconnects Check this box to require that the 
Host be restarted whenever a Guest breaks a con-
nection or the connection is broken accidentally.

Ensuring access to the Host after a 
reboot
At the same time you are configuring a Host for rebooting, 
you can configure it so that a Guest can resume a Laplink 
connection after the Host is rebooted. You can do this by 
setting up Laplink to run whenever Windows is started.
To configure a Host so that it automatically runs 
Laplink each time Windows is started:
• On the Advanced tab of Program Options (Options 

menu), check Always Start Laplink before Windows 
Logon Prompt.

When a Windows 2000, XP or 2003 Host requires the user 
to press CTRL+ALT+DELETE at logon, a Guest can press 
a special key combination specified on the Host.
To specify the key combination for 
CTRL+ALT+DELETE:
• Click Options, and then the Host tab in Remote Con-

trol Options, and change the key combination in this 
box: Send CTRL+ALT+DELETE to this computer 
when a Guest presses this key combination.By default, 
it is CTRL+SHIFT+D.

• Press one of the chosen key combinations 
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Screen Shots & System Information
Laplink now allows you to snap a screen shot from the Host 
computer and save it to your hard drive during a Laplink 
Remote Control session. This is very useful for capturing 
error messages, odd displays, or other behavior that might 
be hard to describe. Using Screen Shot saves technicians 
time when troubleshooting.

Taking a screen shot
To take a screen shot, you must first establish a Remote 
Control session with a Host computer. Once this connection 
has been established, select Session, and then click 
Screen Shot to take a snapshot of the Host desktop. You 
will see the dialog box below.

Window or full screen?
Laplink allows you to take two different types of screen 
shots. If you use Window, you will get a snapshot of the cur-
rent active window on the remote desktop. Choosing Full 
Screen will provide you a picture of the entire remote desk-
top screen. View the difference below:
Full Screen view

Window view
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Saving a screenshot
Once you’ve taken a snapshot of the screen, you can save 
it to your hard drive for later viewing. Laplink saves the 
snapshot as a PNG file, which by default are viewed with 
Internet Explorer. 

NOTE Internet Explorer 5.0 or higher must be in use in 
order to view PNG files. 
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Viewing a screen shot
To review snapshots you’ve taken, click on the Session 
menu, and select View Screen Shot. This opens the View 
Screen Shot dialog, where you can view thumbnail screens 

of your snapshots, view them full screen, and delete screen-
shots you no longer need. You can view captured screens 
any time, whether connected or not.

From the Session menu, choose View Screen Shot. View-
ing is enabled both during a session and when not con-
nected and is the only Session option available when not 
connected. Once you’ve selected a thumbnail snapshot, 
and clicked View, Laplink launches Internet Explorer or 

whatever application your computer has associated with 
PNG files.

TIP If you want to access the PNG files themselves, 
Laplink Gold saves them to the C:\WINNT\TSI32\LLW 
directory. 

 Select Session, View Screen Shot to access previously captured screens.

Highlight a thumbnail, and click 
View to view captured screens.
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Saving system information
Laplink makes it possible to capture important system infor-
mation on the Host computer, and save it to a file on your 

local machine. This troubleshooting tool provides your sup-
port professionals with a single report offering a great deal of 
useful information. 

Laplink saves all Windows system information from the Host 
computer, and exports it to your computer. For this reason, 
you’ll see a dialog asking you where the information should 

be saved. Indicate a location and the Host computer’s infor-
mation will be saved as a text file in the indicated location.

To save system infor-
mation from the Host 
computer to your 
local machine, you 
must first be con-
nected via a Laplink 
Remote Control ses-
sion.

Once this connection 
has been established, 
click Session, and 
then Save System 
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Creating a report
Laplink creates a report that saves your Windows System 
Information. Below are just a few of the headings of informa-
tion contained in your Laplink report.

• System summary information
• Hardware resources
• IRQ information

• Memory
• Components
• Audio and Video Codecs
• Devices
• Display
• Keyboard
• Adapters
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Sharing clipboard information 
Computers in a Laplink Remote Control connection share a 
common clipboard: you can copy or cut information to the 
clipboard on one computer and paste this information on 
another.
When you cut or copy information for pasting in another 
document, the information is stored temporarily in the clip-
board. Normally, clipboard information is transferred 
between documents on the same computer. When you use 
Laplink Remote Control, however, you can use the clip-
board to transfer information from one computer to another. 
You can copy text or graphics on the Host computer, for 
example, and paste it on the Guest.
Only information placed in the clipboard during Laplink 
Remote Control can be pasted on other computers. You 
cannot share any information copied or cut to a clipboard 
before a Laplink Remote Control connection is opened.

TIP When you clear the contents of the clipboard on 
one computer, you clear the clipboard contents of the 
other computer as well.

Pasting from the clipboard during 
Laplink Remote Control
When you copy or cut information to the clipboard during 
Laplink Remote Control, only a small part of the information 
is transferred to the other computer immediately. The rest of 
the information is transferred when you paste.
To prevent the loss of information added to the clipboard 
from the remote computer during Laplink Remote Control, 
paste the information before disconnecting.
If you are controlling several Host computers, information in 
the clipboard on your computer is available to any of them. If 
you want to transfer clipboard information from one com-
puter to another, however, you must first paste the informa-
tion into a document on your Guest computer; then paste it 
into a document on another Host computer.

Disabling clipboard sharing
By default, clipboard sharing is available during Laplink 
Remote Control sessions.
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Customizing Laplink Remote Control Performance
As a Guest, you can change several Laplink Remote Control settings either to speed up performance 
or to enhance your view of the Host screen. When speed is your priority, change the settings to enhance 
performance. When you want the best view of the Host screen, turn off the performance enhancements.

TIP Choose between enhanc-
ing your view of the Host screen 
and speeding up Laplink 
Remote Control performance.

Click one of the preset options.

Or click the Settings button and 
specify your own settings.
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To improve Laplink Remote Control performance, Laplink 
temporarily alters the Host screen by removing its wallpa-
per, screen saver, and other visual enhancements. You can 
restore any of these enhancements. Or you can improve 
performance even more by minimizing the number of bit-
maps and bitmap colors transferred over a connection.
Click the Settings button in Remote Control Options to 
change the quality of your view of the Host screen without 
affecting the Host screen itself.
On the Guest Display tab, adjust these options:
Send Font Information  Displays text and symbols on 
the Guest computer. Checking this box speeds display per-
formance but may not present the most accurate represen-
tation of text and symbols.
Prevent Display of Large Bitmaps  Determines the 
size of the largest bitmap to be displayed in your view, rang-
ing from 32 by 32 to 512 by 512 pixels. Choosing a smaller 
size improves performance but may cause bitmaps not to 
appear in some dialog boxes, wizards, and buttons. (Exper-
iment with the setting, increasing it as necessary to display 
larger bitmaps.)

On the Guest Colors tab, adjust these options:
Use Solid Colors  Displays solid colors instead of dith-
ered, or patterned, colors. Performance is not affected, but 
your view of the Host may improve.
Bitmap Color  Selects the palette used to display bitmaps. 
The values range from Monochrome to True Color (24 bit). 
Choose a palette with fewer colors to improve performance.

Temporarily changing the Host screen
Click the Settings button in Remote Control Options to 
alter your view of the Host by changing the appearance of 
the Host screen itself. When you disconnect, the Host 
screen is restored to its original appearance.
On the Host Display tab, change these settings:
Disable Screen Saver   Keeps the Host’s screen saver 
from running.
Disable Special Windows Effects  Disables several 
Windows features, including desktop wallpaper or patterns, 
animated windows, and Web Page view.
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Using Print Redirection
There are two ways to print over a Laplink connection. While controlling a Host computer, you can print 
from that computer directly to your local printer. Or reverse direction and print directly from your Guest 
computer to a Host printer. Either way, you can use Print Redirection to send a document over Laplink to 
be printed at the opposite end of the connection. 

Once you have opened a Laplink connection, you can use 
Print Redirection to send a document from the computer at 
one end of the connection to a printer at the other end.
There are two ways to use Print Redirection over a Laplink 
connection:
• Print from Host to Guest While using Remote Con-

trol to view and operate a Host computer, you can send 
a document from the Host computer to a printer at your 
location. For example, you can prepare a document on 
your office computer from home and print the document 
on your home printer.

• Print from Guest to Host When connected to a 
Laplink Host computer, you can print a document from 
your computer to a printer attached to the Host. For 
example, after working on a report at home or on the 
road, you can connect to your office computer and print 
the report to a high-quality laser printer in your office.
Without Print Redirection, you’d have to transfer the doc-
ument to the other computer and then use Remote Con-
trol to run a program on the guest computer and print the 
document.

Printing a document over a Laplink connection is much like 
printing it on a local printer; all you do is choose the Print 
command. In Print Redirection you select the printer at the 
opposite end of the connection from the document.

Requirements for Print Redirection
To print documents from a computer to a printer at the other 
end of a Laplink connection, you need to set up the destina-
tion printer on that computer, using the exact same driver. If 
you want to print reports on the office printer while at home, 
for example, set up the office printer on your home com-
puter.You setup a printer for Print Redirection using Print 
Redirection options in Laplink.
Requirements for using Print Redirection:
• You must connect to another version of Laplink that 

supports Print Redirection.
• The default security setup on the other computer must 

be changed to allow Print Redirection.
• Both Laplink computers must have the same printer 

driver (software) installed.
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Setting up Print Redirection
To print documents from a computer to a printer at the other end of a Laplink connection, you need to 
set up the destination printer on that computer. If you do not set it up while installing Laplink, you can set it 
up later, using the Print Redirection Options.

To set up a new printer, click the Setup button in the Print 
Redirection Options dialog box.

Choose the printer from the list.
If your printer arrived with a setup disk, 
click Have Disk.
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Before you can use Print Redirection, you need to add a 
printer for Print Redirection to the computer from which 
you’ll be printing.
For example, if you’re remote controlling your office com-
puter and want to print a document on that computer to your 
printer at home, you need to set up your home printer on the 
office computer.
The print driver you set up must match the destination 
printer exactly. Use the same installation method—CD 
ROM, downloaded driver—on both computers.

CAUTION Using the Printer Redirection wizard in 
Laplink Gold will not ensure that both computers are 
using the same printer drivers. For more information 
about configuring a printer for Laplink Printer Redirec-
tion, see technical document #36 at www.laplink.com/
support. 

Setting up a printer
To set up a printer, click Options, and then click Print 
Redirection Options. Then click Setup to access the 
Print Redirection Setup Wizard. Just as in Windows, 
you can choose your printer manufacturer and printer 
name from a list, type a name for your printer, and then 
click Finish.
For step procedures on installing print drivers, see the 
online help system or manufacturer’s documentation.
Once the printer is set up, you can print to it, and your doc-
ument is sent over your Laplink connection. 

NOTE In order to print, Laplink must be installed and 
connected on both computers.
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Printing Over a Laplink connection
To print over a Laplink connection, choose the standard Print command in any Windows program and 
then choose a printer set up especially to receive print jobs from remote computers. The document is then 
transmitted over the Laplink connection to a printer at the other end.

Print from a Windows program as you normally 
would, using the Print command.

Then choose the 
printer you set up 
for Print Redirec-
tion.
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Printing over a Laplink connection is much like printing to a 
local printer. You simply choose a different printer—one that 
has been installed especially to print over Laplink.
When printing from a Host computer to a local printer, 
choose a local printer from the Host computer using 
Remote Control. When printing from local to a Host com-
puter, choose a Laplink printer from the local computer.
For detailed instructions on setting up and using Print Redi-
rection, see the on-line help system. 

Printing tips
There are a couple of items to note when you are using 
Print Redirection:
• The Print Redirection icon on the Laplink status bar ani-

mates as the document is sent over a Laplink connec-
tion to the destination printer. When the animation 
ends, the document has arrived at the other computer. 
You can then close Laplink if you want.

• You can monitor the document print status after it has 
been sent over a Laplink connection. On the computer 
to which the printer is attached, click Windows Start, 

point to Settings, and click Printers. Then double-click 
the printer icon.

• You can use Print Redirection over a Laplink connec-
tion even when it is not one of the services currently 
open. Print Redirection is available on demand.

Choosing among several printers
Normally, Print Redirection sends documents to the printer 
that has been set up as the default printer on the connected 
computer. If you send a print job from home to the office, for 
example, the printer designated as the default on the office 
computer automatically gets the job. (If there is only one 
printer set up on a computer, that printer is always used.)
If you want to use a printer other than the default, you need 
to set up Laplink to prompt you with a list of available print-
ers whenever you print. Change this setting on the com-
puter the printers are attached to, not the computer with the 
document.

TIP If you’re not in front of that computer, you can still 
change this setting by using Remote Control.
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Using Text Chat
Text Chat lets you exchange typed messages with another Laplink user. Text Chat is useful for 
exchanging brief messages and sending instructions. If you have a microphone, sound card, and 
speakers, you can also use Voice Chat.

Opening Text Chat 
For step-by-step instructions on using Text Chat, see the 
on-line Help system.
To open Text Chat select the service when you connect to 
the Host. If you have an active connection Text Chat can be 
opened from the Window menu or the Shortcut bar.

Text Chat options
You can configure a Text Chat window to open anytime 
someone sends you a message. Text Chat is configured 
from the Options menu. 

Working in Text Chat 
The Text Chat window is divided in two. The lower section is 
where you type your message. Messages are received and 
displayed in the upper section. 

TIP To start a new paragraph, press CTRL+ENTER.
Text Chat supports cut/copy and paste from any text editor. 
Instead of typing messages while connected, you can pre-

Messages are identified by the 
computer names.

Type your messages in the lower 
part. Press ENTER to send.
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pare them ahead of time and paste them into the Text Chat. 
This is especially useful if you have an urgent message to 
send to multiple Laplink computers.

Text Chat and Remote Control
As a Guest during Remote Control, you can carry on a Text 
Chat conversation with the Host (the computer you are con-

nected to) only by viewing the Host screen in a window. (In 
full-screen view, you cannot see your own Text Chat win-
dow.) 
To arrange the Text Chat window beside the Remote Con-
trol window, click Tile Side by Side on the Window menu.
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Using Voice Chat
Voice Chat lets you speak with a person at the other end of a Laplink connection using the same line that 
transfers data between the two computers. Both computers must be configured for full duplex if you are to 
talk as you would on the telephone. If either computer is configured for half duplex, you must wait for the 
other person to stop talking before you begin speaking.

Requirements for Voice Chat
To use Laplink Gold Voice Chat you need:

• A computer that is capable of recording and playing 
sound.

• Microphone.
• Speakers or headphones.
• Sound card; a full duplex sound card is recom-

mended.

Opening Voice Chat
For step-by-step instructions on using Voice Chat, see the 
on-line Help system.
To open Voice Chat select the service when you connect to 
the Host. If you have an active connection Voice Chat can 
be opened from the Window menu or the Shortcut bar.

TIP If you have opened a connection to multiple 
remote computers, select a window for the connection 
before starting Voice Chat.

TIP How you talk to the 
other person in Voice Chat 
depends on whether the cur-
rent conversation is using 
half duplex or full duplex.

You can adjust the volume of the 
speaker and microphone or mute 
them entirely.

When you’re using half duplex, 
watch the icon to determine when 
to talk and when to listen.
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Talking with Voice Chat
Adjust your speaker and microphone volumes so that you 
can hear and be heard comfortably.

TIP For best performance, use Laplink, not Windows, 
sound control levels. 

Depending on the configuration of the sound card in both 
computers, you may be able to talk as you would on a tele-
phone; that is, your voice and the voice of the other user 
can be transmitted simultaneously. This is known as full 
duplex.
If you and the other user are not using full duplex, you must 
talk as you would on a walkie-talkie; that is, you must wait 
for the other person to finish before you begin. The trans-
mission of just one voice at a time is known as half duplex.
Voice Chat conversations are always half duplex unless 
both sound cards are configured for full duplex. 

NOTE Over slower connections, you may not be able 
to use full duplex, because of the lower bandwidth of 
the connection.

Talking using half duplex
When you are having a half-duplex conversation, refer to 
the stoplight icon in the lower right corner of the Voice Chat 
window to know when you can talk. When the light is green 
or the text says “Talk,” you can talk. When the light is red or 
the text says “Don’t Talk,” you should wait until the other 
person has finished talking.

TIP Saying “over” when you are finished talking may 
help facilitate conversation.

Configuring your sound card for full duplex
Some sound cards can be reconfigured for full duplex by 
updating to new sound card driver software. Contact your 
sound card manufacturer to find out whether your sound 
card is capable of full duplex. Updated sound card drivers 
are usually available on the manufacturer’s website. 
The sound card of the person you’re talking to also must be 
configured as full duplex in order for you to talk in full duplex.

NOTE Voice Chat provides an alternate method you 
can use to talk known as Manual mode; see page 140.
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Improving Voice Chat performance
To improve Voice Chat performance, click the Levels tab in 
the Voice Chat Options dialog box, and then configure the 

microphone and speaker levels and specify information 
about your environment.

Use the Levels tab of the Voice 
Chat Options dialog box to con-
figure your speaker, microphone, 
and environment levels.

For the speaker and microphone 
levels, click and drag the sliders 
to the desired level.

Setting the environment level 
helps avoid transmitting sound 
that is not speech. It is recom-
mended that you use the Setup 
button, and not the slider, to 
adjust this level. 

The Levels tab on the Voice Chat Options dialog box lets you perform recording and playback tests 
and measure other speech qualities. Adjust the Levels tab prior to using Voice Chat.
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If you have already used a program that records and plays 
sound in Windows, you probably do not have to change set-
tings for your speakers and microphone before using Voice 
Chat. (For exceptions, see online help.)
However, Voice Chat lets you change settings for your 
speaker, microphone, and environment to improve perfor-
mance in Voice Chat. It is recommended that you do this 
before you start using Voice Chat.

Improving quality over a fast 
connection.
Voice Chat works best over a fast connection. If you use 
Voice Chat over a network or other fast connection, you can 
improve the Voice Chat sound quality. Click Options, and 
then Voice Chat Options. Click Advanced tab to modify 
quality settings.

It is recommended that you set 
up your environment level every 
time you change the transmis-
sion quality.

When you have a slow connec-
tion, using Medium or High may 
cause problems with your con-
nection.

A walkie-talkie button appears in 
the Voice Chat window when you 
select manual mode.
139



Laplink Gold 12
Using Manual conversation mode
Use Voice Chat’s Manual conversation mode if you’re hav-
ing problems using Voice Chat or you want additional con-

trol over when speech is sent over the connection. Manual 
mode requires that you press a button in order to talk.

Voice Chat has two conversation modes: Automatic and 
Manual.
• Automatic is the normal conversation mode, and allows 

hands-free operation of Voice Chat. Automatic mode 
sends speech whenever you talk.

• Manual mode requires you to click a button in order to 
talk.

In most cases, Automatic mode is recommended.
Use Manual mode if:
• You’re having problems using Automatic mode
• Your sound card does not support Automatic mode. 
• Your work environment is very noisy
• You want to control exactly when speech is sent. 

In Manual mode, click the 
walkie-talkie button in order 
to talk.

If you are using full duplex, 
you can leave the button 
down and hear the other 
person. If you are using 
half duplex, you must 
release the button to hear 
the other person.
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Talking in manual mode
Manual mode works differently depending on whether your 
conversation is full duplex or half duplex.
• When using half duplex, you click the walkie-talkie but-

ton once in order to talk. While you’re talking, the other 
person cannot talk to you (he or she sees a “Don’t Talk” 

icon) until you click the button again to release it. The 
other person can then talk.

• When using full duplex, you also click the walkie-talkie 
button once in order to talk, but you don’t need to 
release it to allow the other person to talk, since in full 
duplex, you can both talk at the same time.
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Introduction to Troubleshooting
This chapter provides checklists for solving problems and improving performance. These checklists are 
designed as a quick overview of possible solutions.

For detailed, step-by-step information, consult the trouble-
shooters in online Help. The troubleshooters are designed 
to solve problems you may encounter in opening connec-
tions and using the services once you have opened con-
nections.
To use an online troubleshooter, open the Troubleshoot-
ing book in Help Topics and display one of the topics. 
Then answer the questions about your problem and try the 

suggested remedies. In some cases you will find shortcut 
buttons to dialog boxes; use these buttons to resolve the 
problem faster.
For further assistance, visit www.laplink.com/support. In 
addition to the latest technical information, you’ll have 
access to the following support options: FAQs, Knowledge 
Base, Web incident (email) support, live chat support, and 
fee-based telephone support. 

Use the online troubleshooters for step-by-
step solutions.
On the Contents tab of Help Topics, open 
the Troubleshooting Book and display 
one of the topics.

Try the solution that 
best describes your 
problem.
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Checklist for Modem Connections 
NOTE use a hardware (controller-based) modem, such 
as an external (serial) modem. Laplink Gold works best 
when all the functions of the modem are performed on 
the modem device itself. Use of software-based (con-
trollerless) modems often result in poorer performance 
and reliability, and may be incompatible with Laplink 
Gold. For a list of modems that are known to be incom-
patible with Laplink Gold, visit www.laplink.com/sup-
port. 

Run Laplink on both computers
No connections are possible by modem or any other means 
unless Laplink is running on both computers. You can con-
nect to a computer running Laplink Gold or another Win-
dows-based version of Laplink.

Ensure that the modem can answer a call or dial out
A modem cannot answer an incoming call unless the Auto 
Answer option is on. Click Options, and then Port Setup. 
Then click Windows Modems. Click Configure, and then 
verify that Enabled under Auto Answer is checked.

Test the modem outside of Laplink Gold
Does the modem work with other applications? Test the mo-
dem with other Windows tools, such as dialing your Internet 
Service Provider (ISP) or, if you are using Hyperterminal, en-
sure the modem is working properly.

Check the settings for a Windows modem
If your modem does not answer calls or dial after you have 
enabled it as a Windows modem in Laplink, exit Laplink, and 
make sure the modem is turned on. In the Windows Control 
Panel, double-click Modems, click the Diagnostics tab, and 

click the appropriate port. Click More Info. If the test fails, 
click the General tab, and remove the modem. Shut down 
the computer and then restart it. Return to Modems in the 
Control Panel and reinstall the modem.

Disable error control and data compression on both 
computers
Some modems communicate better if error control and data 
compression are disabled on both computers. to disable er-
ror control, Click Options, and then Port Setup, click Win-
dows Modems, Configure, and then Properties. On the 
Connection tab, click Advanced. Then clear Use Error 
Control. Repeat this procedure on the other computer.

Set a longer timeout value
If the computer you are dialing takes a long time to answer 
and complete the connection, try increasing its modem tim-
eout. To configure timeout, click Options, and then Port 
Setup. Click Windows Modems, and then click Configure 
and Properties. On the Connection tab, type a larger num-
ber in this box: Cancel the Call If Not Connected Within.

Lower the modem speed on the computer opening the 
connection
In Options, click Port Setup, and then click Windows Mo-
dems. Click Configure and then Properties. On the Gen-
eral tab, click a lower speed in the Maximum Speed box.

Check the security setup on the remote computer
If you are denied the use of Remote Control or one of the 
other services while connected to another computer, check 
the security setup on that computer. You can gain access to 
services by clicking Options, and then Security.
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NOTE To let other computers connect to your com-
puter by modem, you must change the security setup 
established during installation. Remember that pass-
words are case-sensitive.

Disable call waiting and answering machines
Ensure that the call waiting feature is disabled on the tele-
phone systems at both ends of the connection. Call waiting 
and answering machines can interfere with modem connec-
tions when incoming calls are detected.

Use Dialing Properties to simplify the dialing process. 
In the Telephone Number box, type the number as it is to be 
exactly dialed, including numbers dialed to get an outside 

line, area codes, country codes, and a “1” when dialing long 
distance. 

Disable other programs that use COM ports while run-
ning Laplink
You may experience problems if you use Laplink to connect 
by modem while running any other programs that monitor 
serial (COM) ports; modem and fax programs as well as 
PDA software, typically monitor serial ports for incoming 
calls or faxes and may cause a modem to disconnect unex-
pectedly. Disable such programs while using Laplink.
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Checklist for Dial-Up Networking Connections
Ensure that Dial-Up Networking is installed
You can connect over Dial-Up Networking only if Microsoft 
Dial-Up Networking has been installed. Dial-Up Networking 
should already be installed. However, if necessary, you can 
install this feature from your Windows 98/Me CDROM as fol-
lows: In the Windows Control Panel, double-click Add/Re-
move Programs. Click the Windows Setup tab, and 
double-click Communications. If Dial-Up Networking is 
checked, it is installed. If it is not checked, click Dial-Up Net-
working, and then click OK to begin installation.

NOTE For more information about Microsoft Dial-Up 
Networking, consult Windows Help.

Once connected using Dial-Up Networking, connect to 
your corporate network
When you connect over Dial-Up Networking in Laplink, you 
dial in to a remote access server and connect to a network. 
Then you make Laplink connections in the Connect Over 
LAN (Network) dialog box. Unless you specify otherwise, the 
list of available Laplink connections appears automatically 
as soon as you are connected to the network. If the list of 
connections does not appear automatically, click the Short-
cut Bar, then Connect. Click Network.
TIP To connect to another Laplink computer once a Dial-Up 
Networking connection is established, make sure that this 
box is checked in the Connect over Dial-Up Networking dia-
log box: After Connecting to the Network, Choose a Laplink 
Connection.

Ensure that your computer is set up for network con-
nections
Making connections to other Laplink computers through 
Dial-Up Networking requires that your computer meet the re-
quirements for network connections in Laplink: 

• a network protocol must be installed
• your network ports must be enabled in Laplink
• for more information about network connections, 

see page 148.
NOTE To let other computers connect to your com-
puter through Dial-Up Networking, you must change 
the security setup established during installation.

Run Laplink on both computers
No connections are possible by Dial-Up Networking or any 
other means unless Laplink is running on both computers. 
You can connect to a computer running Laplink Gold or an-
other Windows-based version of Laplink. Verify that the 
computer has a network port enabled for the same kind of 
network connection as your network port.

Use Dialing Properties to simplify the dialing process. 
In the Telephone Number box, type the number EXACTLY 
as it is to be dialed, including numbers dialed to access an 
outside line, area codes, country codes, and a “1” when dial-
ing long distance. 

Disable other programs that use serial (COM) ports 
while running Laplink
You may experience problems if you use Laplink to connect 
by modem while running any other programs that monitor 
serial (COM) ports; modem and fax software, as well as PDA 
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programs, typically monitor serial ports for incoming calls or 
faxes and may cause a modem to disconnect unexpectedly. 
Disable such programs while using Laplink.

Disconnect a Dial-Up Networking connection manually
When connecting by modem, you can instruct Laplink to 
break a connection after a specified number of minutes in 
which there is no activity at either end of the connection: 
Click Connect Options (Options menu). On the Disconnect 

tab, check the Disconnect Inactive Connections box, and 
type the number of minutes below.
In most cases, the connection is completely broken after the 
specified period. With Dial-Up Networking connections, 
however, you must complete the process: click Disconnect 
(Connect menu) and then click Disconnect All.

TIP Consult the network administrator to ensure that 
the RAS server is accessible and responding to con-
nection requests. 
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Checklist for Network Connections
Enable the network port for Laplink connections
Access to a network does not automatically provide network 
access in Laplink. To connect over LAN (Network) in Laplink, 
your network port must be enabled—that is, made available 
for Laplink’s use. To enable a network port in Laplink, click 
Options, and then Port Setup. Click the type of network—
either IPX or TCP/IP—in the Ports list. Then check the En-
able Port box. If the network is IPX, click Configure, and en-
sure that Internetwork Name Broadcast is checked.

Run Laplink on both computers
No connections are possible by network or any other means 
unless Laplink is running on both computers. You can con-
nect to a computer running Laplink Gold or Windows version 
7.5 or higher of Laplink. Verify that the computer has a net-
work port enabled for the same kind of network connection 
as your network port.

Refresh the list of connections
If Laplink was started on the other computer after you started 
connecting, you may need to refresh the list of available con-
nections in order to include the computer in the list. Click Re-
fresh List, and wait while the list of Laplink computers is 
updated.

Ensure that the network is installed
Laplink cannot connect by network unless a network proto-
col—either IPX or TCP/IP—is installed. Network protocols 
are installed using the Networks option in the Windows Con-
trol Panel. See your Windows Help and documentation for 

information on adding network protocols, or consult your net-
work administrator.

Type the password carefully
In Laplink Gold, passwords are case-sensitive. For more in-
formation, see the Getting Started chapter.

Type the TCP/IP name or address
If you do not see a computer listed as an available connec-
tion over a TCP/IP network, you may have to type the com-
puter’s IP address. Click the Connect button on the LinkBar, 
and then click Network. On the TCP/IP Addresses tab, type 
the IP address or the Windows computer name in the TCP/
IP Name or Address box. (This name usually differs from the 
name assigned to the computer in Laplink.)
TIP To determine the TCP/IP address for a Windows 98 or 
Me computer, click Options, and then Port Setup. Then 
click TCP/IP in the Ports list; and then click Configure. The 
computer’s address appears in the IP Address box.
TIP To determine the TCP/IP address for a Windows XP, 
2000, or 2003 computer, click Start button, and then Run, 
and then at the command line, type CMD.EXE, and press 
Enter. Then type IPCONFIG and press ENTER. The 
address appears on the IP Address line.
TIP If you cannot connect after typing a TCP/IP address, 
disable any firewall software on the Host machine.

Check the security setup of the Host computer

If you receive a “not authorized” error message, be sure to 
change the security setting on the Host from the default of 
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“Private System”. Access security settings from the Options 
menu, then choose Security. 

IPX connections: change the type of frame on both 
computers
Some IPX connections work better if the frame type for the 
IPX connection is preset rather than selected automatically; 

try setting the frame type to Ethernet 802.2 or Ethernet 
802.3. This setting should be changed on both computers 
making a Laplink connection. Network protocols are installed 
using the Networks option in the Windows Control Panel. 
See Windows Help and documentation for information on 
changing the frame type.
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Checklist for Laplink Internet Connections
Both computers must be on the Internet and running 
Laplink Gold 12
It doesn’t matter how it’s done—by dialing in to an ISP or 
connecting over a high-speed connection—but both com-
puters must be connected to the Internet before they can 
connect using Connect over Laplink Internet. Laplink Gold 
12 must be running on both computers.

Both computers must be logged on to the Laplink Inter-
net service
On the Host computer, select Options, and then click 
Laplink Internet Options. On the Guest computer, you can 
either perform the same procedure or log in with your Laplink 
Internet user name and password when you connect.

Check the security setup on the Host computer
If you receive a “not authorized” error message, be sure to 
change the security setting on the Host from the default of 
Private System. To access security settings, select Options, 
and then click Security.

Internet connections between computers behind proxy 
servers may require special configuration
If one or both of the computers is behind a network protected 
by a proxy server, select Options, and then click Laplink In-
ternet Options. Click Advanced and fill in the proxy serv-
er’s authentication information.
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Checklist for ILS-based Internet connections
While the ILS feature remains in Laplink Gold, for connections through the Internet (and through 
firewalls), the Laplink Internet feature is the best choice.

The computer you want to connect to must have its In-
ternet address published by an Internet directory server 
(and you must know what the address is)
Connect over ILS is designed for connecting to a computer 
whose Internet address is published to the Laplink ILS serv-
er. To set up the computer for this kind of connection, click 
Options, and then select Internet Directory Options and 
type an e-mail address or other unique identifier to be pub-
lished as the computer’s Internet address. Let other Laplink 
users connect by sharing the address with them.
TIP Set up Internet Directory Options to have the address 
published automatically. Or publish the address yourself, 
when you are online: on the Connect menu, click Publish 
My Internet Address.
TIP If you are connecting to a computer which has an IP 
address you know, use Connect Over LAN (Network) 
instead and supply the IP Address.

Both computers must be on the Internet and running 
Laplink
It doesn’t matter how it’s done—by dialing in to an ISP or 
connecting over a high-speed connection—but both com-
puters must be connected to the Internet before they can 
connect using Connect over ILS. Laplink must be running on 
both computers.

Enable a TCP/IP port in Laplink
To connect over the ILS in Laplink, a TCP/IP network port 
must be enabled, that is, made available for use in Laplink. 
To enable a TCP/IP port in Laplink, click Options, and then 
click Port Setup. Click TCP/IP in the Ports list and then 
check the Enable Port box. 

Check the security setup on the Host computer
If you receive a “not authorized” error message, be sure to 
change the security setting on the Host from the default of 
Private System. Access security settings from the Options 
menu, then choose Security.

Internet connections between computers behind rout-
ers and firewalls may require special configuration
Without proper configuration, Laplink connections over the 
ILS may be prevented if either of the computers is behind a 
firewall or router. This may be a personal router appliance, or 
a corporate network’s firewall.
To facilitate Laplink connections over the Internet, Laplink 
has registered port 1547 with the Internet Assigned Num-
bers Authority. This port is used by the Host computer. To al-
low Laplink connections through a router or firewall, a 
network administrator should configure the router or firewall 
to forward TCP port 1547.

NOTE If you have any questions about your corporate 
network, consult your network administrator.
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Checklist for Cable Connections
Important: Different cable types are supported for differ-
ent versions of Windows.
Serial cable: All versions of Windows
Parallel cable: Windows 98/Me
USB cable: Windows 98, Me, 2000, XP, and 2003.

Ensure that Autoconnect is turned on
Autoconnect opens cable connections for you automatically. 
To ensure that Autoconnect is in effect, click Options, and 
then click Connect Options. On the Connect tab, verify that 
this box is checked: Enable Autoconnect. Below the op-
tion, verify that the services you want to use are also 
checked.
TIP If you have trouble maintaining a cable connection, try 
disabling Autoconnect on one or both of the computers.

Run Laplink on both computers
No connections are possible by cable or any other means 
unless Laplink is running on both computers. 

NOTE For USB connections with the Gold USB 1.1 
cable or the Iogear Smartlink 2.0 USB cable, the other 
computer must be running Laplink Gold, version 11.5 or 
higher.

Check the cable
Make sure that each end of the cable is securely attached to 
the proper port; check the port labels for proper identification. 
Check a parallel cable for damaged pins. Try reconnecting 
the cable to each port or even reversing the cable ends.
TIP Attach a yellow Laplink cable to parallel/LPT (printer) 
ports. Attach a blue Laplink cable to serial/COM (modem or 
mouse) ports; connect only one end to each computer. 

Laplink does not work over most other serial cables or any 
printer cables. Attach a Laplink USB cable to a USB port at 
each computer. Do not use a non-Laplink USB cable. 

Consult the Windows Device Manager when in doubt 
about USB or other kinds of ports
If you are not certain whether you have a USB port or anoth-
er kind of port, check the Windows Device Manager: Right-
click My Computer, and then click Properties. Look on the 
Device Manager tab, or click the Device Manager button on 
the Hardware tab.
All Laplink USB cables should appear in the Windows De-
vice Manager. 

NOTE Serial and parallel cable connections never 
appear in the Device Manager.

Enable the port
You cannot connect by cable until a port is enabled—that is, 
made available specifically to Laplink. To enable a port for 
cable connections, click Options, and then click Port Setup. 
Click the port you want to enable. Then check the Enable 
Port box.
TIP If a port is listed as unavailable, quit any program that 
may be using the port, such as Palm software, fax, and 
other applications. Make sure that the cable is attached to 
an available port.
TIP Do not install any separate USB drivers for all Laplink 
USB cables. Laplink Gold has the built-in drivers. If the gold 
cable has been configured on either computer for use with 
an older version of Laplink (using USB network drivers), you 
may experience problems connecting. Contact Laplink 
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technical support for assistance. Visit www.laplink.com/sup-
port for more information.

Serial cable connections: lower the speed of a serial 
port
In Options, click Port Setup, click the COM port to which the 
cable is attached. Click Configure. In the Port Speed box, 
click 57600. Repeat this procedure on the other computer. If 
you still can’t connect, repeat the procedure, lowering the 
speed one step at a time until you can connect.

Restart the computer
If all else fails, remove the cable from both computers, and 
restart the computers. Reattach the cable, and try the con-
nection again.

Improving parallel cable performance in Windows 98 
and ME
There are three drivers you can use in Laplink for parallel 
ports: the Laplink Enhanced driver (the default), the Laplink 

Standard driver, and a Windows driver. The Laplink En-
hanced driver is preferable when you alternate between par-
allel communications and other types of communications: 
you can leave the parallel port enabled without experiencing 
any degradation of performance. The Windows driver, on 
the other hand, generally provides better performance for 
parallel connections; use the Windows driver if you intend to 
use parallel connections exclusively. If you then want to 
switch to modem or some other type of communication, be 
sure to disable the parallel port beforehand.

NOTE For maximum performance from an ECP port, 
use the Windows driver for the parallel port to which the 
cable is attached.

To change the parallel port driver, click Options, and then 
click Port Setup. Select the appropriate LPT port. Ensure 
that the Enable Port box is checked. Click Configure and 
then click one of these options: a. ) Use the Windows Driv-
er, b.) Use the Laplink Enhanced Driver, or c.) Use the 
Laplink Standard Driver.
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Checklist for CAPI 2.0/ISDN Connections
Run CAPI-compatible versions of Laplink on both com-
puters
No connections are possible by CAPI 2.0/ISDN or any other 
means unless Laplink is running on both computers. Ensure 
that the version of Laplink running on that computer is com-
patible with CAPI 2.0/ISDN.

Check the security setup on the remote computer
If you are denied the use of Remote Control or one of the 
other services while connected to another computer, check 
the security setup on that computer. You can gain access to 
services by clicking Options, and then clicking Security.

Ensure that Laplink is set up to answer calls over CAPI 
2.0/ISDN
CAPI cannot answer an incoming call unless the Auto An-
swer option in Laplink is enabled. In Options, click Port Set-
up. Then select CAPI 2.0/ISDN, and click Configure. Verify 
that the Enable box under Auto Answer is checked.

If you are using ISDN in North America, avoid using the 
Laplink CAPI 2.0/ISDN
In North America, ISDN doesn’t usually include CAPI 2.0 but 
you can still use your ISDN device in Laplink. If the device is 
set up as a Windows (TAPI) modem, you can open a Laplink 
connection using Connect over Modem or Connect over 
Dial-Up Networking. Simply ensure that the device is en-
abled as a Windows modem by clicking Options, and then 
Laplink Port Setup. If your ISDN device is set with its own 
dialer, use the dialer to log on to a network. Then, in Laplink, 
use Connect Over LAN (Network) to connect to other com-
puters running Laplink on that network.

Close some Laplink services to allow connections over 
both channels
Normally CAPI 2.0/ISDN Hosts on which channel bonding is 
not enabled can handle incoming connections on both chan-
nels. When only one connection is possible, try closing ser-
vices on that connection.
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Checklist for File Transfer
Drop files directly on target folder
The most common mistake in drag and drop is dropping files 
on the wrong target folder (the folder to receive the files). To 
help prevent this mistake, open the target folder first; the 
name of the folder now appears in the title bar. Then open 
the source folder and select and drag the files until the 
mouse pointer rests on the open folder and the folder is high-
lighted. As soon as you release the mouse button, you re-
ceive a confirmation dialog box showing, among other 
things, the target you just dropped on. Check the target, and 
change it if necessary.
TIP To ensure that files are copied, press CTRL while drag-
ging. To ensure that files are moved, press SHIFT while 
dragging.
TIP If you are copying an entire folder (rather than files 
within a folder), drop the folder on the target one level higher 
than where you want the files to appear; this may be 
another folder or a drive letter. Assume that you want to 
update your Letters folder on your desktop computer with 
your Letters folder from your laptop, and the Letters folder 
appears at the highest level of folders on drive C. Drag the 
folder from the laptop to the desktop and drop it on drive let-
ter C.
TIP If you have File Transfer difficulties, such as error mes-
sages or disconnections, try reducing the amount of data 
being sent, either by reducing the number of files sent or 
size of sent files. 

CAUTION Do NOT attempt to move the entire con-
tents (root) of a drive. Windows may create hidden files 
or folders that could be in use and cannot be trans-
ferred. Likewise, do not attempt to transfer directories 
containing the Windows operating system. Laplink Gold 

cannot move any data that has been locked or is in use, 
such as the Windows Registry. If you wish to ‘clone’ a 
drive for the purpose of making a bootable operating 
system on the target drive, use drive imaging software 
designed for these purposes instead of Laplink Gold.
If you need to copy the entire contents of your com-
puter, try Laplink’s PCMover. More information can be 
found at: www.laplink.com/products

Use the Copy or Move command
Instead of using drag and drop, use the Copy or Move com-
mand. First, click the target folder. After selecting the files to 
be transferred, click File, and then click Copy or Move. Then 
verify that the source and target are correct.

Make File Transfer available to other computers
If you are denied the use of File Transfer or one of the other 
services while connected to another computer, check the se-
curity setup on that computer. You can gain access to ser-
vices by clicking Options, and then Security.

Log on to Windows before trying to use File Transfer
As a security measure, Laplink does not allow users to con-
nect to a computer and open File Transfer while the comput-
er is waiting to be logged on to Windows. (When you attempt 
to open a File Transfer connection to a computer running 
Laplink and displaying the Windows logon dialog box, you 
see the error message: Creation of window failed.
The solution is to open a Remote Control connection first. 
Log the remote computer on to Windows and then open File 
Transfer.

NOTE To set up Laplink to run before the Windows 
logon dialog box appears, click Options and choose 
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Program Options. Choose the Advanced tab, and 
check this box: Always Start Laplink before Win-
dows Logon Prompt.

General tips for faster transfers
Follow these suggestions to improve transfer speeds:
•  Check the folders and files you have selected for trans-

fer, making sure that you are not including more than 
necessary. For example, have you selected an entire 
folder when you want to transfer only a few files within 
the folder?

•  Use SpeedSync to improve file transfer times when 
updating files, particularly over modems: on the Perfor-
mance tab of File Transfer Options, make sure that the 
Use SpeedSync on All File Transfers box is checked.

•  Disable any ports that are not in use. To disable unused 
ports, click Options, and then 9. Click an unused port, 
and then clear the Enable Port box.

•  Close other service windows and any connections to 
other computers you may have opened in Laplink.

•  On laptop computers, disable power management 
functions. Attach the AC adapter to the computer to 
ensure steady voltage throughout the transfer.

•  Disable screen savers, and close other programs.
•  Serial cables transfer data at 0.4Mbps, while the Laplink 

Gold USB 1.1 cable can transfer data at up to 5Mbps. 
For Laplink USB 2.0 cable connections, transfer rates 
can be up to 100 Mbps.

Tips for transfers over a serial cable
•  Ensure that the serial port is configured for maximum 

speed. Click Options, and then click Port Setup. Select 
the appropriate COM port. Click Configure and ensure 
that Port Speed is set at 115200.

•  Change the transfer mode to standard. Click Options, 
and then Port Setup. Select the appropriate COM port; 
click Configure, and select Standard under Transfer 
Mode.

Tips for transfers over modems
Consult the documentation for your modem and verify that 
the port speed is set for optimum performance. Click Op-
tions and then click Port Setup. Click Windows Modems, 
and then click Configure, select the modem you are using, 
and then click Properties. In the Maximum Speed list on 
the General tab, click the maximum speed your modem can 
use.

Tips for transfers over a network
•  Transfer your files when there is less network traffic.
•  Ask your system administrator to verify that the network 

drivers are current.

Tips for SmartXchange
Use SmartXchange to update files in two folders so that the 
folders share the latest files. Since SmartXchange always 
overwrites older files, do not use it if you want to merge the 
contents of two files. Use SmartXchange by opening the two 
folders you want to update; do not select the individual files. 
Click SyncTools, and then click SmartXchange. Verify that 
you have opened the right folders. If you do not want to add 
new files to either folder, check this box: Transfer Only If 
Files Are Already on Target.

Ensure that you have read access rights to network files 
you want to copy
If you can locate the files you want to copy but then are de-
nied access when you attempt to copy them, contact the net-
work administrator. You can copy only files to which you 
have been assigned read access.
156



Laplink Gold 12

Checklist for Xchange Agent
Ensure that Laplink is running on the Host computer
Laplink must be running on the Host computer before an 
agent can connect to it and synchronize files. On the Guest 
computer, keep Windows actively running. (Laplink will start 
automatically when the agent runs.)

Make sure that a scheduler program is running
To schedule Xchange Agents—and have them run on 
schedule—you must have a supported scheduler program 
running.

NOTE When Laplink Scheduler is running, a red alarm 
clock icon appears on the Windows taskbar.

Change an Xchange Agent schedule in your scheduler 
program
Once you've created an Xchange Agent schedule in Laplink, 
revise or delete the schedule in the scheduler program itself.

Close an Xchange Agent before it is scheduled to run
An agent cannot run on schedule while it remains open in 
Xchange Agent.

Create an Address Book entry to meet the security re-
quirements of the remote computer
If the remote computer requires a name and password, cre-
ate an Address Book entry and include the name and pass-
word required by that computer. Laplink can then send this 
information and connect automatically.

Turn off the Laplink callback feature
If the Host computer requires or requests a callback before 
opening a modem connection, the agent cannot run. On the 
Host computer, turn off the callback feature: Click the Secu-

rity button on the LinkBar. On the Log-in List tab, click the 
name of the Guest computer and then click Edit. Under Mo-
dem Callback, click None.

Avoid moving or deleting agent files for which you have 
created shortcut icons
If you have moved or deleted the Xchange Agent file, the 
shortcut icon can no longer run the agent. Create the agent 
again. You can reuse the shortcut icon by saving the new file 
in the same location, with the same name, as the original file. 
Or you can create a shortcut icon for the new agent file.

Create a filter to synchronize a single file
Xchange Agent always synchronizes by folder pairs, but you 
can create a filter so that only one file within a folder pair is 
synchronized. Open the agent in Xchange Agent and click 
the folder pair. On the Edit menu, click Set Filter and then 
click New. After typing a description for the filter, type the 
complete name of the file, including its extension. (To add 
more than one file name, type a semicolon and then the next 
file name.) Click OK. Click the filter’s name in the Available 
Filters list, and then click Add.
TIP Preview the agent to see if the correct files are included 
in the synchronization.

Use Preview to limit the files to be copied in the current 
synchronization
While previewing an agent, you can specify that certain pairs 
of files and folders will be omitted from the current synchro-
nization: Click a pair of files or folders and then click the Skip 
Pair button on the toolbar. Repeat this procedure for any oth-
er pairs you do not want synchronized. Then, before closing 
Preview or quitting Xchange Agent, run the agent.
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TIP You can omit file and folder pairs only from the current 
synchronization. To remove them from a future synchroni-
zation, you must use Preview again.

Use Xchange Agent to overwrite, not merge, files
Xchange Agent overwrites files. Unless you specify other-
wise, it copies the newer file to the other computer. It does 
not merge files. To merge databases and other shared files, 
use the program in which the files were created.
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Checklist for Remote Control
Improve performance from the Guest
On the Guest, you may be able to speed up Remote Control 
connections by changing settings by clicking Options, then 
Remote Control Options on your computer. On the Perfor-
mance tab, click the Best Performance option. (To further 
customize settings, click the Settings button.) Your view of 
the Host should be updated faster, though you will now be 
viewing the Host screen in black and white, and larger bit-
maps will not be displayed.

Control the display properties of the Host from the 
Guest
By default, Laplink is configured to speed up Remote Control 
connections: any wallpaper or screen saver on the Host is 
temporarily disabled, along with certain other visual en-
hancements. From the Guest, you can restore these en-
hancements to the Host screen through settings on your 
computer. In Options, click Remote Control Options, and 
then click the Performance tab. Select Best Quality. (To 
further customize settings, click the Settings button.) Keep 
in mind that changing these settings may slow Remote Con-
trol connections.

Make Remote Control available to other computers
If you are denied the use of Remote Control or one of the 
other services while connected to another computer, check 
the security setup on that computer. You can gain access to 
services through Security (Options menu).

Use the keyboard to view the Host screen
If the window in which you are viewing the Host screen does 
not show all of the Host screen, you can use your keyboard 
to view areas beyond the borders of the window: press 

CTRL+ALT+SHIFT and any of the arrow keys, PAGE UP, 
PAGE DOWN, HOME, or END.

Use the latest driver for your video adapter
Contact the manufacturer of your video adapter, on its Web 
site or elsewhere, to verify that you are using the latest driver.
New computers do not necessarily ship with the most cur-
rent drivers installed.

Avoid changing the color depth or display properties of 
a Host
From the Guest, avoid changing the number of colors dis-
played on the Host while you're connected to it using Re-
mote Control. Also avoid changing the Refresh Frequency 
and other settings in the Host's Display Properties while con-
nected. To safely change these properties, you should be 
seated at the Host and fully informed of the capabilities of its 
monitor. Incorrect settings can damage a monitor.

Use a special key combination to log on to a Windows 
2000, XP or 2003 Host
When you restart a Windows Host, you must press 
CTRL+ALT+DELETE to log on to Windows again. You can 
accomplish this from the Guest by pressing a special key 
combination specified on the Host. (Pressing 
CTRL+ALT+DELETE on the Guest affects the Guest, not 
the Host.) To specify a key combination for use on the Guest, 
start Laplink on the Host and click Remote Control Options 
(Options menu). On the Host tab, type the key combination 
in this box: Send CTRL+ALT+DELETE to This Computer 
When a Guest Presses This Key Combination.
TIP The easiest way to send a CTRL+ALT+DEL to the Host 
machine is to:
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1 Establish a Remote Control session with the Host 

machine.
2 Click on the Session menu, and select Send 

CTRL+ALT+DEL to Host.

Do not install other remote control products and Laplink 
on the same computer
Because of possible incompatibilities, avoid installing Laplink 
Gold and another remote control product, such as PCAny-
where®, on the same computer.

CAUTION Installing Laplink Gold with another remote 
control application installed may result in a failure to 
reboot (except in Windows Safe Mode.) For more infor-
mation on allowing these programs to coexist with 
Laplink, visit www.laplink.com/support. 

Avoid pressing CTRL+ALT+DELETE when viewing a 
Windows 2000, XP or 2003 Host in full-screen Remote 
Control
Pressing CTRL+ALT+DELETE on a Windows computer al-
ways displays the Windows Security dialog box on that com-
puter. When you are working in a full-screen Remote Control 
session, pressing CTRL+ALT+DELETE not only displays 
the Security dialog box locally but also causes the CTRL and 
ALT keys to be pressed—but not released—on the Host 
computer. To release these keys and resume normal key-
board operation press CTRL and ALT again.
TIP To have CTRL+ALT+DELETE take effect on a Host 
computer, click Send CTRL+ALT+DELETE to Host on the 
Guest's Session menu.

Keep Laplink running before the Windows 2000, XP or 
2003 logon prompt
If you have set up Laplink on the Host computer to run before 
the Windows logon dialog box appears, avoid closing 
Laplink on that computer unless you have administrator 
rights. If you close Laplink, you will have to restart the com-
puter in order to reset Laplink so that other people can con-
nect. (Restarting Laplink is not sufficient.)

Avoid running a Windows 2000, XP or 2003 Host in VGA 
mode
When a Windows computer is running in VGA mode you can 
make Laplink connections from it to other computers using 
Remote Control and File Transfer, but the computer cannot 
serve as a Remote Control Host. That is, it cannot be re-
motely controlled by other computers.

Run DOS in a window on a Windows 2000, XP or 2003 
Host
You cannot control full-screen DOS programs on a Windows 
Host. When you attempt to do so, Laplink minimizes the pro-
gram and displays a warning message. (To close the DOS 
program, right-click the icon, and click Close.)
Avoid this problem by setting up the Windows Host to display 
DOS programs in a window. If you use a shortcut to a DOS 
program, for example, right-click the shortcut icon, click 
Properties, and then click the Options tab. Below Display 
Options, check Window.
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Checklist for Laplink Remote Desktop
Activating Windows Remote Desktop on the Host Com-
puter
Before you can connect Laplink Remote Desktop the Host 
computer must be set to accept Remote Desktop connec-
tions.
To activate Windows Remote Desktop in Windows XP:
1 On the Host computer, click Start, and then Control 

Panel.
2 If your Control Panel is set to display in Category View, 

click Performance and Maintenance, and then click Sys-
tem.
If your Control Panel is set to display in Classic View, 
click System.

3 From the System dialog box, click the Remote tab.
4 Select the Allow users to connect remotely to this com-

puter checkbox.
5 Click OK .

User account passwords and Remote Desktop
Windows 2000 and Windows XP Professional both have 
settings that allow for the creation of user accounts that are 
not protected by passwords. The Windows Remote Desk-
top feature will not connect to a computer that has no pass-

word-protected accounts. If at least one account is 
password-protected, Remote Desktop will connect and dis-
play a login screen. If the account used to log in is not pass-
word protected the login is refused and the connection 
closed.
To password-protect an account in Windows XP:
1 On the Host computer, click Start, and then Control 

Panel
2 Click User Accounts.
3 From the accounts available, choose the account which you 

want to password-protect. 
NOTE You can also simply create a new account.

4 Select Create a password.
5 Create a password and a password hint.
6 Click Create Password.

Has the Host computer granted permission?
Before you can connect, the Host computer must give you 
permission to use Remote Desktop.
If you are the owner of the Host computer, you can grant 
permission by changing the Security options on that com-
puter.
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Checklist for Print Redirection
Use the same printer driver on both ends of a connec-
tion
For best print results in Print Redirection, both computers 
must be set up with the exact same printer driver. To add a 
printer driver, you may a disk from the printer manufacturer, 
or you may be able to download the latest driver from the 
manufacturer’s website.

Use the Windows Control Panel to get additional infor-
mation
If the document you printed is sent over Laplink correctly but 
does not print, examine the printer queue, accessed by click-
ing Start, Programs, and then Printers to get additional in-
formation about why the document didn’t print. Make sure 
the printer is connected correctly and has enough paper, and 
the printer cartridge is not empty.

When several printers are available, you can set up 
Laplink to prompt you for the printer to use
Normally, Laplink automatically directs print jobs to the print-
er currently set up as the default printer at the other end of 
the connection. When there are several printers available, 

however, you may want to use a printer other than the de-
fault.
To set up Laplink to allow you to choose among the available 
printers, click Options, and then click Print Redirection Op-
tions on the computer the printers are attached to. Then 
click Prompt with a List of Available Printers.

When printing from 16-bit programs, use the default 
printer
Before printing from 16-bit Windows programs (programs 
written for versions of Windows prior to Windows 95, Win-
dows 98, and Guest 4.0), set up the destination printer as the 
default printer on the computer to which it is attached. When 
using Print Redirection from the 16-bit Windows program, 
print to the default printer instead of selecting a printer from 
the list of available ones.

Some printer drivers do not support Print Redirection
To use Print Redirection you must set up a printer to direct 
print jobs to a special TSI port instead of the usual parallel 
port. You cannot use a printer driver that does not allow you 
to change the port in this way. You may want to contact the 
printer manufacturer to see if an updated driver is available.
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Checklist for Text Chat
Press ENTER to send your message
Type your message in the lower part of the Text Chat win-
dow. (In some cases, you may have to click in the lower part 
of the window before you can begin typing.) To send your 
message to the remote computer, press ENTER.
TIP To begin a new paragraph, press CTRL+ENTER.

Open a Text Chat window after connecting
If you are connected to more than one computer, be sure to 
specify which computer you want to use Text Chat with: 
Click the name of the computer on the Window menu. Then 
click the Open Text Chat button on the Shortcut Bar or 
Open Text Chat in the Windows menu.

Make Text Chat available to other computers
If you are denied the use of Text Chat or one of the other ser-
vices while connected to another computer, check the secu-
rity setup on that computer. You can gain access to services 
by clicking Options, and then Security.

Save your Text Chat conversation from time to time
As a Text Chat conversation grows in length, the most recent 
messages begin to replace the earliest. This starts to hap-
pen when the conversation exceeds 32,000 characters. If 
you intend to save a lengthy conversation, begin saving be-

fore this limit is reached. To save a conversation, scroll to the 
upper part of the Text Chat window, click Edit, and then Se-
lect All. Then click Edit, and then select Copy. You can then 
switch to another Windows program such as Notepad, paste 
the text, and save it as a file.

Shorten connection time by preparing messages be-
forehand
Instead of typing text while connected, you can prepare it 
ahead of time in Notepad or a similar Windows program and 
send it to a remote computer through Text Chat. In the other 
application, select the text, and press CTRL+C to copy. In 
the lower part of the Text Chat window, press 9 to paste. 
Then press ENTER to send.

Use File Transfer for long messages
Text Chat can send as many as 2,048 characters at once. 
When you attempt to send a message that exceeds that lim-
it, part of the message will not be transmitted to the other 
computer. Try sending the message in parts. Or save the 
message as a file, and send the file using File Transfer. You 
can still use the Text Chat window to let the remote user 
know what you’re sending and to pass along additional 
notes.
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Checklist for Voice Chat
Use full duplex sound card drivers on both ends of the 
connection
Voice Chat is easiest to use over a full duplex connection; 
you can hear and be heard at the same time, as on the tele-
phone.
For full duplex, both ends of the connection must have sound 
cards with drivers that support full duplex. Contact your 
sound card manufacturer to determine whether your sound 
card supports full duplex; and find out whether drivers are 
available.

When using half duplex, wait for the other person to fin-
ish talking
A common problem in half duplex conversations is knowing 
when to start talking. Use the stoplight icon in Laplink as a 
guideline for when you can talk and when you can’t. In some 
cases, a verbal signal that you are finished speaking (saying 
“over,” for instance) might be helpful, or it might help to sim-
ply pause a few seconds when you are done speaking.
If you’re using Manual mode, be sure to release the walkie-
talkie button; you might not be able to hear the other person 
otherwise.

Adjust your microphone to a comfortable level
Many microphones require adjustment in order to send clear 
speech. Make sure your microphone is placed at a good dis-
tance from your mouth—not too far and not too close—and 

then adjust the microphone level. Click Voice Chat Op-
tions, and then use the Levels tab.

Adjust your speakers or headphones to a comfortable 
level
Most speakers, and some headphones, have a manual con-
trol that you can use to adjust volume. It is recommended 
that you leave the manual controls at a medium level, and 
adjust the volume of speakers and headphones in Laplink. 
For best results, adjust the Laplink sound levels, not those 
available in Windows.

Minimize background noise, if possible
Try moving your microphone away from telephones, loud 
computer power supplies, radios, and so on. Move your 
speaker and microphones farther apart.
If the person you’re talking to hears a lot of noise in your 
background or doesn’t hear your voice, you might want to re-
set your environment level by clicking Voice Chat Options, 
and then use the Levels tab.

Tips for improving Voice Chat performance
Perform the tests by clicking Voice Chat Options, and then 
selecting Levels tab to get the best performance. Adjust 
transmission quality to match the conditions of the connec-
tion: In the Options menu, click Voice Chat Options, and 
then select the Advanced tab. Click Low if you are talking 
over a modem or other slow connection. Click High if you 
are talking over a network or other fast connection.
164


	Contents
	1 Introducing Laplink Gold
	Welcome

	2 System Overview
	Features, Tools and Users

	3 Getting Started
	Getting Started
	Configuring Security
	General security
	Local security

	Encryption
	Lockout

	Configuring the Address Book
	View options and folders
	Address Book window
	Adding an Address Book entry
	Address Book - Connection tab
	Services tab

	More Address Book toolbar options


	4 Using File Transfer
	About File Transfer
	Configuring File Transfer Options
	SpeedSync and Compression
	Antivirus options


	Manually Transferring Files & Folders
	SyncTools
	Clone Folder
	SmartXchange

	Xchange Agents
	Creating an Xchange Agent
	Previewing and running an Xchange Agent
	Dealing with conflicts
	Customizing an Xchange Agent
	Using filters to include or exclude files
	Scheduling an Xchange Agent to run automatically

	Navigating through drives and folders
	1. Open Laplink Gold on both machines on your account. Laplink Gold 12 must be running on machines with which you will establish a connection.
	2. On the Shortcut Bar, click Connect Over Laplink Internet.
	3. This will bring up the Laplink Internet Logon dialog box. Enter your username and password and click OK.
	4. The Connect Over Laplink Internet selection dialog box appears. Click the computer name that you wnat to connect to, and select the services that you want to use.
	5. Click OK. The connection will be established with the services that you have selected.


	5 Connecting
	Types of Connections
	Determine your connection type
	Table 1: Connecting over the Internet
	Table 2: Connecting over cable, networks or modems


	Connecting by Cable
	Connecting by Laplink Internet
	Connecting by LAN (Network)
	Connecting to previous Laplink versions behind firewalls

	Connecting by Modem
	Connecting by Dial-Up Networking
	Other Connection Types
	Connecting over wireless (infrared)
	Connecting over CAPI 2.0/ISDN
	Connecting via Internet Locator Service


	Configuring and Saving Connections
	Handling Saved Connections

	How to Connect
	Description of the Connect Options Dialog Box
	1. Click Start, and then Control Panel. Click the System icon.
	2. If you can’t see the System icon, click the Switch to Classic View link in the Control Panel Shortcuts menu.
	3. Click the Remote tab and select the Allow users to connect remotely to this computer check box.
	4. Ensure that you are either an administrator or a member of the Remote Desktop Users group on your computer.
	5. Click OK. For more information on using Windows XP Remote Desktop, consult your Windows XP online help system.


	6 Remote Desktop & Remote Control
	Laplink Remote Desktop & Laplink Remote Control
	About Laplink Remote Desktop
	About Laplink Remote Control
	Hosting a Laplink Remote Control Session
	Controlling a Laplink Remote Control Session
	Viewing the Host
	Customizing keyboard control
	Disabling the Host keyboard and mouse and blanking its screen
	Rebooting and logging on to the Host
	Screen Shots & System Information

	Saving a screenshot
	Viewing a screen shot
	Saving system information
	Creating a report
	Sharing clipboard information


	Customizing Laplink Remote Control Performance

	7 Using Print Redirection
	Using Print Redirection
	Setting up Print Redirection
	Printing Over a Laplink connection

	8 Using Text & Voice Chat
	Using Text Chat
	Using Voice Chat
	Improving Voice Chat performance
	Using Manual conversation mode


	9 Troubleshooting
	Introduction to Troubleshooting
	Checklist for Modem Connections
	Run Laplink on both computers
	Ensure that the modem can answer a call or dial out
	Test the modem outside of Laplink Gold
	Check the settings for a Windows modem
	Disable error control and data compression on both computers
	Set a longer timeout value
	Lower the modem speed on the computer opening the connection
	Check the security setup on the remote computer
	Disable call waiting and answering machines
	Use Dialing Properties to simplify the dialing process.
	Disable other programs that use COM ports while running Laplink

	Checklist for Dial-Up Networking Connections
	Ensure that Dial-Up Networking is installed
	Once connected using Dial-Up Networking, connect to your corporate network
	Ensure that your computer is set up for network connections
	Run Laplink on both computers
	Use Dialing Properties to simplify the dialing process.
	Disable other programs that use serial (COM) ports while running Laplink
	Disconnect a Dial-Up Networking connection manually

	Checklist for Network Connections
	Enable the network port for Laplink connections
	Run Laplink on both computers
	Refresh the list of connections
	Ensure that the network is installed
	Type the password carefully
	Type the TCP/IP name or address
	Check the security setup of the Host computer
	If you receive a “not authorized” error message, be sure to change the security setting on the Host from the default of “Private System”. Access security settings from the Options menu, then choose Security.
	IPX connections: change the type of frame on both computers

	Checklist for Laplink Internet Connections
	Both computers must be on the Internet and running Laplink Gold 12
	Both computers must be logged on to the Laplink Internet service
	Check the security setup on the Host computer
	Internet connections between computers behind proxy servers may require special configuration

	Checklist for ILS-based Internet connections
	The computer you want to connect to must have its Internet address published by an Internet directory server (and you must know what the address is)
	Both computers must be on the Internet and running Laplink
	Enable a TCP/IP port in Laplink
	Check the security setup on the Host computer
	Internet connections between computers behind routers and firewalls may require special configuration

	Checklist for Cable Connections
	Important: Different cable types are supported for different versions of Windows.
	Ensure that Autoconnect is turned on
	Run Laplink on both computers
	Check the cable
	Consult the Windows Device Manager when in doubt about USB or other kinds of ports
	Enable the port
	Serial cable connections: lower the speed of a serial port
	Restart the computer
	Improving parallel cable performance in Windows 98 and ME

	Checklist for CAPI 2.0/ISDN Connections
	Run CAPI-compatible versions of Laplink on both computers
	Check the security setup on the remote computer
	Ensure that Laplink is set up to answer calls over CAPI 2.0/ISDN
	If you are using ISDN in North America, avoid using the Laplink CAPI 2.0/ISDN
	Close some Laplink services to allow connections over both channels

	Checklist for File Transfer
	Drop files directly on target folder
	Use the Copy or Move command
	Make File Transfer available to other computers
	Log on to Windows before trying to use File Transfer
	General tips for faster transfers
	Tips for transfers over a serial cable
	Tips for transfers over modems
	Tips for transfers over a network
	Tips for SmartXchange
	Ensure that you have read access rights to network files you want to copy

	Checklist for Xchange Agent
	Ensure that Laplink is running on the Host computer
	Make sure that a scheduler program is running
	Change an Xchange Agent schedule in your scheduler program
	Close an Xchange Agent before it is scheduled to run
	Create an Address Book entry to meet the security requirements of the remote computer
	Turn off the Laplink callback feature
	Avoid moving or deleting agent files for which you have created shortcut icons
	Create a filter to synchronize a single file
	Use Preview to limit the files to be copied in the current synchronization
	Use Xchange Agent to overwrite, not merge, files

	Checklist for Remote Control
	Improve performance from the Guest
	Control the display properties of the Host from the Guest
	Make Remote Control available to other computers
	Use the keyboard to view the Host screen
	Use the latest driver for your video adapter
	Avoid changing the color depth or display properties of a Host
	Use a special key combination to log on to a Windows 2000, XP or 2003 Host
	Do not install other remote control products and Laplink on the same computer
	Avoid pressing CTRL+ALT+DELETE when viewing a Windows 2000, XP or 2003 Host in full-screen Remote Control
	Keep Laplink running before the Windows 2000, XP or 2003 logon prompt
	Avoid running a Windows 2000, XP or 2003 Host in VGA mode
	Run DOS in a window on a Windows 2000, XP or 2003 Host

	Checklist for Laplink Remote Desktop
	Activating Windows Remote Desktop on the Host Computer
	User account passwords and Remote Desktop
	Has the Host computer granted permission?

	Checklist for Print Redirection
	Use the same printer driver on both ends of a connection
	Use the Windows Control Panel to get additional information
	When several printers are available, you can set up Laplink to prompt you for the printer to use
	When printing from 16-bit programs, use the default printer
	Some printer drivers do not support Print Redirection

	Checklist for Text Chat
	Press ENTER to send your message
	Open a Text Chat window after connecting
	Make Text Chat available to other computers
	Save your Text Chat conversation from time to time
	Shorten connection time by preparing messages beforehand
	Use File Transfer for long messages

	Checklist for Voice Chat
	Use full duplex sound card drivers on both ends of the connection
	When using half duplex, wait for the other person to finish talking
	Adjust your microphone to a comfortable level
	Adjust your speakers or headphones to a comfortable level
	Minimize background noise, if possible
	Tips for improving Voice Chat performance




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
    /KOR <FEFFd5a5c0c1b41c0020c778c1c40020d488c9c8c7440020c5bbae300020c704d5740020ace0d574c0c1b3c4c7580020c774bbf8c9c0b97c0020c0acc6a9d558c5ec00200050004400460020bb38c11cb97c0020b9ccb4e4b824ba740020c7740020c124c815c7440020c0acc6a9d558c2edc2dcc624002e0020c7740020c124c815c7440020c0acc6a9d558c5ec0020b9ccb4e000200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /CHS <FEFF4f7f75288fd94e9b8bbe7f6e521b5efa76840020005000440046002065876863ff0c5c065305542b66f49ad8768456fe50cf52068fa87387ff0c4ee563d09ad8625353708d2891cf30028be5002000500044004600206587686353ef4ee54f7f752800200020004100630072006f00620061007400204e0e002000520065006100640065007200200035002e00300020548c66f49ad87248672c62535f003002>
    /CHT <FEFF4f7f752890194e9b8a2d5b9a5efa7acb76840020005000440046002065874ef65305542b8f039ad876845f7150cf89e367905ea6ff0c4fbf65bc63d066075217537054c18cea3002005000440046002065874ef653ef4ee54f7f75280020004100630072006f0062006100740020548c002000520065006100640065007200200035002e0030002053ca66f465b07248672c4f86958b555f3002>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice




